# Contents

1. **Introduction** 7  
   New Features in Natural Scene Designer Pro 7.0 9  
   Major Features 11  
   System Requirements 14  
   Technical Support 14  
   About this Manual 14  

2. **Getting Started** 15  
   Installation 15  
   Conventions Used in This Manual 15  
   Basic Overview for Using Natural Scene Designer Pro 17  

3. **Tutorials** 21  
   Rendering a Picture 21  
   Using the Map and Camera Settings Windows 24  

4. **Menus** 27  
   File Menu 27  
   Edit Menu 29  
   Terrain Menu 30  
   Objects Menu 31  
   Overlays Menu 33  
   Path Menu 35  
   Render Menu 36  
   Windows Menu 37  

5. **Terrain Models and Settings** 38  
   Natural Scene Designer Pro Terrain Models 38  
   Opening Terrain Models from 3D Terrain Model Discs 39  
   Terrain Information Dialog 40  
   Importing Grayscale Pictures as DEMs 40  
   Importing Ascii Grid DEMs 41  
   Combining Adjacent Imported DEMs 41  
   DEM Clipping 41  
   Creating Fractal Terrains 42  
   Creating Terrain Models 43  
   World Settings 44  
   Terrain Settings 45  
   Bump Mapping 47  
   Vertical Exaggeration 48  
   Bitmap Terrain Overlays and DRGs 48
<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Image and Scale to Fit</td>
<td>48</td>
</tr>
<tr>
<td>Import DRG or DOQ</td>
<td>49</td>
</tr>
<tr>
<td>Import Georeferenced Image</td>
<td>50</td>
</tr>
<tr>
<td>Importing Shape Files</td>
<td>51</td>
</tr>
<tr>
<td>Overlays Panel</td>
<td>51</td>
</tr>
<tr>
<td>Sky Settings</td>
<td>52</td>
</tr>
<tr>
<td>Clouds</td>
<td>53</td>
</tr>
<tr>
<td>Animating Clouds</td>
<td>53</td>
</tr>
<tr>
<td>Water Settings</td>
<td>54</td>
</tr>
<tr>
<td>Trees</td>
<td>55</td>
</tr>
<tr>
<td>Background Trees</td>
<td>56</td>
</tr>
<tr>
<td>Background Tree Map</td>
<td>58</td>
</tr>
<tr>
<td>Background Tree Map Editor</td>
<td>60</td>
</tr>
<tr>
<td>Bushes</td>
<td>60</td>
</tr>
<tr>
<td>Rock Generator</td>
<td>61</td>
</tr>
<tr>
<td>Rock Texture</td>
<td>62</td>
</tr>
<tr>
<td>Exporting Terrain</td>
<td>63</td>
</tr>
<tr>
<td>Light Settings</td>
<td>64</td>
</tr>
<tr>
<td>Sun Position According to the Date and Time</td>
<td>65</td>
</tr>
<tr>
<td>Multiple Lights</td>
<td>66</td>
</tr>
</tbody>
</table>

6. **Rendering**
   - Rendering a picture | 69 |
   - Quick Test Rendering | 70 |
   - Ray Tracing | 70 |
   - Shadow Mask | 71 |
   - Distance Mask | 71 |
   - Height Mask | 71 |
   - Sky Mask | 72 |
   - Panorama | 72 |
   - Transparent Sky | 72 |
   - Shaded Relief Maps | 73 |
   - Plan Oblique Relief Maps | 75 |
   - Viewshed Maps | 76 |
   - Contour Maps | 77 |
   - Saving Vector Files which Match Rendered Images | 79 |

7. **Texture Shading**
   - Introduction | 81 |
   - Outline of the steps | 81 |
   - Texture Shading Tutorial | 82 |

8. **Georeferencing**
   - Introduction | 85 |
   - Information you will need | 85 |
   - Georeferencing methods | 85 |
   - Entering Projection Parameters | 86 |
   - Entering Reference Points | 87 |
   - Georeferencing Tutorial | 88 |
   - Globe Rendering Tutorial | 91 |
<table>
<thead>
<tr>
<th>Map Projection</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>British Grid</td>
<td>141</td>
</tr>
<tr>
<td>California Teale Albers</td>
<td>142</td>
</tr>
<tr>
<td>Chamberlin Trimetric</td>
<td>142</td>
</tr>
<tr>
<td>Eckert IV</td>
<td>143</td>
</tr>
<tr>
<td>Equidistant Conic - 1 Parallel</td>
<td>143</td>
</tr>
<tr>
<td>Equidistant Conic - 2 Parallels</td>
<td>144</td>
</tr>
<tr>
<td>Geographic</td>
<td>144</td>
</tr>
<tr>
<td>Gnomonic</td>
<td>145</td>
</tr>
<tr>
<td>Goode Homolosine</td>
<td>145</td>
</tr>
<tr>
<td>Hammer - Aitoff</td>
<td>146</td>
</tr>
<tr>
<td>Lambert - Azimuthal</td>
<td>146</td>
</tr>
<tr>
<td>Lambert Conformal Conic</td>
<td>147</td>
</tr>
<tr>
<td>Mercator</td>
<td>147</td>
</tr>
<tr>
<td>Miller</td>
<td>148</td>
</tr>
<tr>
<td>Mollweide</td>
<td>148</td>
</tr>
<tr>
<td>Natural Earth</td>
<td>149</td>
</tr>
<tr>
<td>Natural Earth II</td>
<td>149</td>
</tr>
<tr>
<td>Oblique Mercator</td>
<td>150</td>
</tr>
<tr>
<td>Orthographic</td>
<td>150</td>
</tr>
<tr>
<td>Patterson</td>
<td>151</td>
</tr>
<tr>
<td>Perspective</td>
<td>151</td>
</tr>
<tr>
<td>Polyconic</td>
<td>152</td>
</tr>
<tr>
<td>Robinson</td>
<td>152</td>
</tr>
<tr>
<td>Sinusoidal</td>
<td>153</td>
</tr>
<tr>
<td>State Plane 1927</td>
<td>153</td>
</tr>
<tr>
<td>State Plane 1983</td>
<td>154</td>
</tr>
<tr>
<td>Stereographic</td>
<td>154</td>
</tr>
<tr>
<td>Tilted Perspective</td>
<td>155</td>
</tr>
<tr>
<td>Transverse Mercator</td>
<td>155</td>
</tr>
<tr>
<td>Two Point Equidistant</td>
<td>156</td>
</tr>
<tr>
<td>US Albers</td>
<td>156</td>
</tr>
<tr>
<td>UTM</td>
<td>157</td>
</tr>
<tr>
<td>Van der Grinten</td>
<td>157</td>
</tr>
<tr>
<td>Web Mercator</td>
<td>158</td>
</tr>
<tr>
<td>Winkel I</td>
<td>158</td>
</tr>
<tr>
<td>Winkel II</td>
<td>159</td>
</tr>
<tr>
<td>Winkel Tripel</td>
<td>159</td>
</tr>
</tbody>
</table>

**Appendix B - Map Datums**

<table>
<thead>
<tr>
<th>Datums</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition</td>
<td>160</td>
</tr>
<tr>
<td>Supported Datums</td>
<td>160</td>
</tr>
</tbody>
</table>

**Index**

<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>166</td>
</tr>
</tbody>
</table>
Natural Scene Designer Pro 7.0 is a 3D terrain rendering and animation program, optimized for running on 64 bit systems with multiple processors. A 32-bit version is also included. It uses three dimensional terrain models to create realistic pictures, animations, and shaded relief maps of landscapes, complete with clouds, trees, bushes, rocks, lakes, oceans, snow, and imported 3D objects. These scenes can be explored from any perspective, or you can draw a flight path and create an animation. The lighting, colors, and many other settings are adjustable to achieve different effects.

It can create contour maps, which can be draped over the terrain or exported as a shapefile for use with other software. It also creates viewshed maps, which are maps of what is visible from a given point.

The program can georeference and reproject terrain models and images, which makes it useful for working with maps.

The U.S. Geological Survey (USGS) has digitally mapped the United States. There are three common sampling resolutions available. The entire US is available at a 10, 30 or 90 meter sample spacing. In addition most of the world is available at 90 meter sample spacing.
Using these terrain models, you can reconstruct a realistic representation of the actual location. Additionally, Natural Scene Designer Pro generates realistic terrain texturing using algorithms that simulate natural processes in placing trees, vegetation, and snow. Or you can use a terrain overlay, such as a satellite photo, instead of the program generated texture.

The program CD-ROM contains nearly one thousand 30 meter terrain models for part of California and Nevada. These terrain models are easy to load—you simply drag or click the mouse pointer over the area you want. Additional CD-ROMs and DVD-ROMs covering most of the world are currently available separately from Natural Graphics. Please check the website at www.naturalgfx.com for the most current product information.

Also on the program CD-ROM are a simulated Moon landscape and a Mars landscape with a matching photograph overlay from NASA’s Viking mission. Render a scene or simulate a flight through actual Mars terrain!

Explore imaginary landscapes with Natural Scene Designer Pro’s fractal landscape generator. Fractal landscapes are created using random numbers to simulate the natural processes that formed the earth. By specifying a random “seed” number, mountain height, and the size of the fractal world, you have instant access to millions of fractal landscapes.

This program can render realistic natural scenes and animations, 360 degree panoramas, and shaded relief maps. It is a tool for creating map backgrounds, studying topography, 3D visualization of distant locations, planning trips, and creating fly-through animations.
Natural Scene Designer Pro was designed to be fast, powerful, and easy to use. For flexibility, there are many ways to accomplish some of the most frequently used functions — such as changing the camera location and viewing angle. This lets you choose whatever works best for you. Also, with the rapid update speed of the Camera window you can quickly compose the frame of view. You’ll know what the scene looks like without having to fully render it.

**New Features in Natural Scene Designer Pro 7.0**

**Multiple Lights** - The program now gives you the option of placing multiple lights on a terrain model. Each area of the terrain will be lit according to the light direction you choose.

**Export vector artwork** — Line artwork exported from NSD Pro 7 will now be transformed to match rendered 3D scenes or plan oblique relief. The artwork is saved as an ‘SVG’ file for maximum compatibility with other software.

**Texture Shading** — NSD Pro 7 now includes texture shading as a built-in rendering option. Previously this required opening a separate program.

**Improved Terrain Editor** — The terrain editor is much faster, allowing you to paint with continuous brush strokes. There are keyboard shortcuts for toggling the tools and changing the brush size. Also you can now paint terrain over void areas (where there is no terrain) to fill any gaps.

**Spherical VR Panoramas**— There is a new rendering option in NSD Pro 7 to create a full 360 degree view in one image.

**Background Tree Editor** — The background tree editor now shows the tree mask as transparent green so you can still see the underlying terrain.

**New Projections** — Version 7 adds support for the Natural Earth, Natural Earth II, Patterson, Web Mercator, Van der Grinten, and Chamberlin Trimetric projections.

**IMG DEM import**— NSD Pro 7 imports IMG DEMs, which is one of the new DEM formats distributed by the USGS.

**Improved TIFF DEM import** — More types of TIFF images may be imported, including tiled TIFFs.

**Ray Trace preview** — The Camera View has a new ‘Ray Trace’ button, offering a convenient way to preview the final output.

**New parameter for Geographic projection** — The Geographic projection now lets you set the central meridian to your preference.

**Filling void areas of terrain**— The Terrain menu now has a “Fill Void Areas” function, which was previously available only during SRTM DEM import. Now it can be done at any time.

**Automatic update checking** — At startup, there is an option for the program to automatically check for updates when connected to the internet. You can change this option in the Preferences settings.

**Contour Map Generator** — NSD Pro 7 can now create contour maps and drape them over the terrain or save them as shapefiles.

**Viewshed Map Generator** — A very flexible viewshed map generator has been added. This lets you create a map of areas that are visible from any selected viewpoint.

**Importable Background Tree Maps** — The program can now import background tree maps, giving you total control of where you want background trees to appear.
Background Tree Color and Size Variation — There are new options available for randomly varying the size and color of background trees, for a more natural look.

New Settings Panel — A tabbed settings panel is now always available for convenient access to the most commonly used settings.

Shaded Relief Zooming — The Shaded Relief and Planimetric Oblique rendering dialogs now let you zoom in and limit the rendering to a selected area of interest.

Multiple File Loading and Importing — When opening NSD project files or importing DEMs, you can ‘Shift’ or ‘Command’ click to combine multiple files.

Export DEM as Ascii Grid — This DEM file format is now supported for both importing and exporting.

Adjustable Water Reflectivity — You can change the water reflectivity and preview the result.

New Option for Foreground Haze — Haze can be eliminated completely for a variable distance in front of the camera.

Remove Lakes Feature — Lakes can now be removed at any time, even after ‘Undo’ is no longer available.

Photoshop® PSD and PSB support — The program can now import and export Photoshop PSD and PSB files. PSB files are capable of storing extremely large images of up to about 4 exabytes in size. PSD files can store up to 4 gigabytes.

Improved Terrain Clipping — Terrain clipping is easier to use and more flexible. You can now change the terrain clipping rectangle after you draw it, or numerically enter the clip border. Clipping is performed only after you have had a chance to review or change the clipping rectangle.

Added Control of Bump Maps — You can set the transition range (in vertical meters) for bump maps. This avoids harsh transitions in texture.

Adjustable Brightness / Contrast — The brightness and contrast of pictures, animations, shaded relief, planimetric oblique relief and viewshed maps are now adjustable.

Shapefiles Display Points — NSD Pro 6 displays points in shapefiles. The previous version supported only lines and polygons.

Shadow Mask — This rendering option is now available in the Render Picture dialog. You can create mask images to use along with full renderings for special effects.
Major Features

Rendering — Ray tracing, optimized for natural landscapes, provides the greatest level of realism. The program uses multiple processors, if present, to speed up ray tracing. Or you can use the “Quick Test” renderer, which allows you to check scene composition or view an animation flight path without spending the time to do a complete rendering. Many parameters are adjustable to achieve numerous creative effects. Rendered images may be saved in TIFF, PSD, PSB, JPEG, PNG or BMP format.

Animation — A built-in animation system lets you draw a camera flight path on the map and create an animation. The camera path may contain straight and curved segments, and the camera can be set to automatically bank (like an airplane) around curves. The program allows you to vary the speed along the path. 3D objects and clouds can be given a direction and speed during an animation. Animations are saved as either an AVI file, a QuickTime movie (32 bit version only), or a series of separate frames. You can render animations in multiple rendering sessions using the program’s suspend and resume functions. The program can recover a partial animation that was stopped for any reason, even a power outage, so you can continue rendering from the point it stopped.

Shaded Relief and Planimetric Oblique Relief Maps — The program can create relief maps with user selected colors and elevation ranges. Lighting, color blending, shading, and other parameters are adjustable.

Contour Map Generator — You can create contour maps with major and minor contour lines and save them as shapefiles.

Viewshed Map Generator — The viewshed map generator lets you create a map of areas that are visible from any selected viewpoint. Or you can display the areas that are invisible. You have a choice of color and transparency to mark the viewshed.

Georeferencing — The program can georeference images and terrain models. You can drape a georeferenced image over a terrain model, or save it as a GeoTiff for use in another program. There are several methods for georeferencing, depending on the projection that the image or terrain model uses. Most terrain models are automatically georeferenced when you open or import them.

Reprojection — 40 of the most common projections and all US State Plane systems are available. Interactive dialogs guide you through the entire reprojection process. A quick preview is available to help you make sure the output is what you expect, and you can go back and change the parameters if necessary.

Datums — Over 230 datums are supported. You can easily convert images and terrain models from one datum to another.

Trees — Add realistic redwood, oak, palm, and sweet gum trees to your landscape scenes. The leaf and bark colors, leaf percent, elevation range and density of coverage can be changed. Tree trunks are textured for maximum realism when they are within close range. They can be exported as 3D objects for use in other 3D programs.

Background Trees — You can let the program place trees automatically, or paint the areas on a map where you want trees included (or excluded). Or you can import a bitmap image and use it as a background tree map. This could be used for simulating the cleared area of a ski slope, golf course fairway, or a path through a forest. Options are available for randomly varying the size and color of background trees, for a more natural look.
Settings Panel — A tabbed settings panel allows for convenient access to the most commonly used settings.

Multiple File Loading and Importing — When opening NSD project files or importing DEMs, you can ‘Shift’ or ‘Control’ click to combine multiple adjacent files.

Bump Maps — You can import a bitmap and use it as a terrain bump map, creating a virtually unlimited number of terrain texture varieties.

Shapefile Overlays — You can import a shapefile and use it as a terrain overlay. The program supports points, lines, polygons, and filled polygons. It does not display text attributes.

Adjustable Brightness / Contrast — The brightness and contrast of pictures, animations, shaded relief, planimetric oblique relief and viewshed maps is adjustable with a real-time preview.

Mask Rendering — You can render bitmap masks showing shadows, distance, height, or the sky. These can be useful for creating special effects in image editing programs.

Decollaring — You can remove the border of a digitized topographic map (DRG) so that it may be seamlessly combined with other adjacent maps.

World files — When saving a georeferenced image, you can optionally create a TFW “world file” for use with other software. The world file describes the location and scale of the image.

GeoTIFF support — The program can read and write TIFF files containing georeferencing information.

Terrain Editing — The program’s terrain editing tools let you make changes interactively. There are tools for setting the elevation, raising, and lowering areas. With adjustable brush hardness, changes can be blended into the surrounding terrain.

Color — The color and texture of each terrain feature is adjustable. An additional coloring method is available, which lets you set the colors according to the elevation.

Fractal Terrains — The built-in fractal landscape generator can quickly create a random fractal terrain. Many parameters are adjustable, allowing you to create a wide variety of terrain types.

Terrain Models — The CD-ROM included with this program contains nearly one thousand 30 meter terrain models of California and Nevada. A Mars terrain with a matching photograph overlay is included also.

Terrain Overlays — The program can import images and drape them over the terrain. If the image is a GeoTIFF, Digital Raster Graphic (DRG) or has an associated “world file” it will be automatically aligned to match the underlying terrain. You can also import and overlay shapefiles.

Combining Terrain Models — Natural Scene Designer Pro can automatically combine adjacent terrain models, so you are not limited to working with only one at a time. You can easily combine hundreds of 7.5’ terrain models by drag selecting them on a map when a terrain CD/ DVD-ROM is loaded.

Clipping Terrain Models — Cut out the area of the terrain that you want and discard the rest, in order to save memory and rendering time.

Vertical Exaggeration — Terrains may be stretched vertically by a variable amount. This helps emphasize small features on low elevation terrain models.
**Map** — The Map window shows a shaded relief view of the terrain. It also shows the current camera location, field of view, flight path, overlays, and 3D objects placed in the scene. The program can zoom in on an area of interest up to a magnification factor of 512X. There is a zooming out tool to view the entire map at once. A “profile” mode is available to show the altitude changes of the camera flight path.

**Camera window** — The Camera window always shows the current view. Push buttons let you easily pan or move the camera viewpoint. Other tools let you change the composition of the picture.

The preview in the camera window is rendered using OpenGL™ (if available on your system). This allows the program to show textures and add realism to the preview.

**Toolbar** — The toolbar gives you instant access to some frequently used functions and tools. Some tools have keyboard shortcuts.

**Input File formats** — Natural Scene Designer Pro loads project files which contain terrain models, 3D objects, camera settings, and all of the other parameters needed to create a scene.

It imports Digital Elevation Models (DEM’s) in many formats and DRGs from the U.S. Geological Survey.

The program can create a terrain by importing a picture, where the intensity of each pixel is used to determine the elevation. Or you can create a text file containing elevation samples at a regular spacing and import it as a terrain.

A terrain photograph overlay can be imported, replacing Natural Scene Designer Pro’s algorithmic texture. You can also load shapefiles.

The program will load and display TIFF, PSD, PSB, JPEG, PNG, and BMP pictures.

3D Studio™ (3DS) and QuickDraw 3D™ (3DMF) objects may be imported and placed in your scenes. Many of the QuickDraw 3D primitives are supported. Textures (if present) are mapped to the object and rendered.

**Output File formats** — Natural Scene Designer Pro saves project files which may contain terrain models, 3D objects, and all of the settings to create a scene.

The currently loaded terrain can be exported as a USGS DEM, GridFloat DEM, Ascii Grid DEM, DXF, 3DS or 3DMF file, along with a matching color map for use in other 3D programs.

The terrain can also be exported as a grayscale image, where light pixels represent the highest elevations and dark pixels are the lowest.

Rendered images can be saved as TIFF, PSD, PSB, JPEG, PNG or BMP files. If the image is georeferenced, you may save it as a GeoTIFF and an optional “world file”.

Animations are saved as AVI, QuickTime (32-bit version only) or separate pictures for each frame.

360 degree panoramas may be saved as spherical panoramic images.

**Trees** — Add realistic redwood, oak, palm, and sweet gum trees to your landscape scenes. The leaf and bark colors, leaf percent, elevation range and density of coverage can be changed. Tree trunks are textured for maximum realism when they are within close range. They can be exported as 3D objects for use in other 3D programs.

**Background Tree Map Editing**— You can let the program place trees automatically, or paint the areas on a map where you want trees included (or excluded). This could be used for simulating the cleared area of a ski slope, golf course fairway, or a path through a forest.
Bushes — Natural Scene Designer Pro’s bush generator lets you create bushes for your scene. The leaf and bark colors can be modified. They can be exported as 3D objects for use in other 3D programs.

Rocks — The rock generator creates realistic rocks. The shape of each rock, its color, texture, and other parameters are adjustable. With this amount of control a wide variety of rocks may be created. They can be exported as 3D objects for use in other 3D programs.

Clouds — Natural Scene Designer Pro uses fractal methods to create realistic cirrus and cumulus clouds. You can set the cloud altitude, density of coverage, speed and their direction of movement during animations.

Sky — To add realism and depth, Natural Scene Designer Pro lets you choose sky colors or a blend to create a gradual transition from the zenith to the horizon. The amount of haze is adjustable.

Solar Position Calculation — You can enter the date and time and have the program determine the sun location.

Water — Add lakes to a landscape by clicking over the desired lake location in the Map window. Specify an ocean level to simulate flooding the landscape below the chosen level.

You can adjust the wave height and transparent water color for different effects.

System Requirements
Natural Scene Designer requires a PC with a 1 GHz or faster processor, 1 GB of RAM, a CD-ROM drive, and a 1024x768 or higher resolution monitor. It runs on Windows XP, 7, 8, and 10.

QuickTime animations require the 32 bit version of this program and QuickTime 7.0 or higher.

Technical Support
If you cannot solve a problem after checking the appropriate section of the manual, you may call Technical Support at (916) 740-2953. Our hours are 1 to 5 PM Pacific time, Monday through Friday.

Online support: You may also contact us online for technical support at www.naturalgfx.com/contact.htm. Be sure to indicate the program version and the operating system version.

Phone support: Please note the version number of the program before you call (shown on your program CD-ROM). If possible, have your computer on with the program running, and write down any error messages that were displayed and the procedure that resulted in the problem.

About this Manual
The first three chapters of this manual are designed to be read sequentially. They contain installation instructions, a basic overview, and some tutorials. After reading these three chapters you should have sufficient information to use Natural Scene Designer Pro.

The rest of the manual is for reference. It explains how to use all the dialogs, windows, menus, and tools. While reading the first three chapters, you might want to look up a topic in the reference chapters.

Some of the material in the tutorials is repeated in the reference chapters, which cover most topics in greater detail.
Getting Started

Installation
To install this software:

1. If you do not have a prior version of Natural Scene Designer Pro installed, skip to step 2.

   If you are upgrading from a prior version, you must uninstall it first. Run “Add/Remove Programs” from the control panel and select “Remove”.

2. Insert the program CD-ROM in the CD disk drive.

3. To install Natural Scene Designer Pro, double click on “Setup32” or “Setup64” (if you have a 64-bit OS) and follow the prompts.

4. A shortcut to Natural Scene Designer Pro will be placed on your desktop. Also, a menu will be added to “Programs” in your “Start” menu.

5. The first time you run the program, it will require the presence of the CD-ROM in your drive. Subsequent usage will not require it, unless you want access to the examples and tutorial files.

You are now ready to begin using this program!

Conventions Used in This Manual
You should enter all distances and coordinates in meters. All angles are entered in degrees, and the Camera lens focal length is in millimeters.

Natural Scene Designer Pro lets you position a simulated camera anywhere, and pointing in any direction. The southwest corner (lower left corner as viewed on a map) is the origin or the point with the coordinates East 0, North 0. As you go farther east (farther right on the map) this East coordinate value increases. As you go farther north (farther toward the top of the map) the North coordinate value increases.

Natural Scene Designer Pro uses three angles to describe the camera direction. First, the compass direction (in degrees) indicates the direction that the camera is pointing. Enter north as 0 degrees, east as 90 degrees, south as 180 degrees, and west as 270 degrees. You may, of course, use any angle in between.
The second angle, referred to as “pitch”, is the angle between level ground and the camera view direction. For example, a camera aimed at the horizon has a pitch of 0 degrees. If it points straight down it has a pitch of -90 degrees, and if it points straight up the pitch is 90 degrees. Pitch values greater than 90 degrees or less than -90 degrees indicate that the camera is upside down.

The third angle is the bank angle. In order to understand banking, it is helpful to consider a real world example such as an airplane. In this case, the airplane is said to bank when either wing dips in preparation for a turn. A positive bank angle is a clockwise rotation. For example, +45 would be for an airplane making a right turn. A value of either 180 or -180 would be like flying upside down. A value of zero is no banking (e.g. airplane flying level). Note that the ground will appear to have rotated in the opposite direction of the camera.

Specify the camera lens value as the desired focal length in millimeters. Use values that are appropriate for a standard 35 mm camera. A normal lens is 55 mm. Wide angle is 18 to 35 mm, and telephoto is 100 to 400 mm.

Note that you need to press Return after typing numeric values in the Camera Settings panel and the Camera window. Otherwise changes will not take effect.
However, you should not press Return in dialog numeric fields until you are done with the entire dialog. When you press Return in a dialog field, it will record the settings for all fields and exit out of the dialog.

**Basic Overview for using Natural Scene Designer Pro**

This section will give you an overall understanding of how to use Natural Scene Designer Pro. The details will be fully explained later.

![Camera View Window](image)

Natural Scene Designer Pro has two main windows. The window titled “Camera View” always shows a preview of the current camera view. It also has controls to adjust the bank and pitch, and buttons to move the camera.
The Map window shows a shaded relief rendering of the terrain. Using the default settings, dark green indicates the lowest elevations. Brown indicates even higher elevations, and gray indicates the highest spots. If you run the mouse pointer over the map, you will see the coordinates displayed at the top of the window for the location the pointer is at. The two lines which form a “V” show the camera field of view. A curve shows the camera path (if one has been defined). Small squares along the camera path indicate the location of the key frames. (Key frames are described in the “Animation” chapter).

If a project contains 3D objects, they are shown on the map in solid white (red for the selected object). If the map scale is too large, the object will be represented by a small white or red square. You can magnify the map up to a factor of 512X for more precise object placement and manipulation.
The Settings Panel is a tabbed window with access to the most commonly used settings. When the **Camera** tab is selected, it displays the current camera position (**East**, **North** and **Alt** fields) and the camera direction, pitch, bank, and lens focal length.

You can change the camera position and direction using any of the three windows — Map, Camera, or Camera Settings panel (whichever is most convenient). Changes will be instantly indicated in the other two windows. Often it is convenient to compose the view by selecting a rectangular area in the Camera window using the **Magnifying** tool. You can quickly zoom in on a particular area of interest.

Another convenient feature is the **Undo** button. You can undo the most recent camera movement, direction or lens change, or terrain edit by clicking the **Undo** button on the Toolbar. You can also undo the placement of a lake if there is enough available memory.

Natural Scene Designer Pro can render a single picture from the current camera viewpoint, or animate camera motion along a flight path you define (described in the “Animation” chapter).

The basic steps required to create a single picture are simple. First you need to either load an existing landscape by choosing **Open Terrain CD/DVD-ROM** from the File menu, or create a new fractal terrain by choosing **Create Fractal Terrain**. Then you can use any of the camera controls to compose the view. You may change the settings in the Settings panels, modify the colors, and adjust the lighting. You can change the settings in any order, or use the default settings. Finally, when you are ready to render a picture, choose **Render Picture** from the Render menu.

To create an animation, you must define a camera path. Once a path is defined, choose **Render Animation** from the Render menu.

Natural Scene Designer Pro uses key frame animation to define a camera path. Each key frame contains the camera position, direction, bank, pitch, and speed. You create key frames at the critical points along the path. When the program processes the animation it interpolates the frames in between.
Clouds and 3D objects may be animated too. They may be assigned a speed and direction of travel, independently of the camera path.

You may save your complete or partial work environment including the landscape, settings, 3D objects, and camera path by choosing **Save** or **Save As** from the File menu.

Now you should have a basic idea of how to use Natural Scene Designer Pro. You may wish to begin experimenting, or continue reading for complete instructions.
Tutorials

Rendering a Picture
This tutorial will take you, step by step, through the process of rendering a picture. For a thorough explanation of each of the subjects mentioned here, please refer to the appropriate reference section following the tutorials.

Before you begin this tutorial, be sure that you have properly installed this software (See Chapter 2, “Getting Started”).

Soon after you start the program you will see the main windows — the Camera View window, the Map window, and the Settings panel. Whenever you load an existing landscape or create a fractal landscape, the Camera View window displays it from the current camera viewpoint. Changing the camera location, direction, lens, lighting, ocean level, and various other settings will automatically update this window. The Camera View window shows only a rough approximation of the actual landscape (it is much more detailed when rendered). The view will not show clouds, waves, background trees or textures.
First, make sure the program CD-ROM is in your CD drive. Then choose **Open Terrain CD/DVD-ROM** from the **File** menu. You will see a new window showing a large scale shaded relief map. Click or drag select the area you want. Then click **Open**. After the terrain has been loaded, the view will be quickly shown in the Camera View window.

First, position the camera to a good viewing location within the terrain. This is easily done using the six direction buttons below the preview image. There are buttons for moving up, down, left, right, forward, and backward. Clicking these buttons moves the camera in the specified direction. The camera will move by the amount (in meters) specified in the **Distance** field. Note that movement is always relative to the direction the camera is pointing, not the landscape. For example, if the camera is pointing straight up, then clicking the **Fwd** button will increase the camera altitude. If the camera is aimed level to the horizon, then clicking the **Fwd** button will move the camera toward the horizon.

Try clicking the six direction buttons a few times and experiment with various distance values. (Note that you need to press **Return** after changing the value in the **Distance** field, otherwise it will not take effect). You can use the **Undo** button in the Toolbar to return to your previous camera location and viewing direction.

![Magnifier tool](image)

You can change the composition of your picture by selecting the **Magnifier** tool and using the mouse to drag a rectangle over the desired area. First, select the Camera View window (if it is not already selected). Then move the mouse pointer to what you want to be the upper left corner of the picture. Press and hold down the mouse button while you move it to the lower right corner of the picture, then release it. You will now see the new camera view.

To change the view direction using the **Magnifier** tool without zooming in, click the mouse button anywhere in the Camera View window. The location you click will become the new center of view. To pan, select the **Hand** tool and drag the image.

There are keyboard shortcuts for panning and zooming. Press **Space** to temporarily switch to the **Hand** tool. When you release the space bar it will return to the previous tool. Press **Control + Space** to switch to the **Magnifier** tool, and **Shift + Space** to zoom out.
You can also pan (rotate) the camera view using the four pan arrow buttons. Each button press pans the camera view by a fixed amount. For finer panning control, you should use the **Hand** tool and drag the image in the Camera View window.

When satisfied with your picture composition, choose **Render Picture** from the Render menu. (Or click the **Render** tab on the Settings panel). You can adjust the picture dimensions, resolution, and some rendering options, or you may use the default settings. Note that there are multiple rendering options. If you want a quick test, but with visible polygons, select the **Quick Test** option. For a full rendering, select **Ray Trace**.

Once you have adjusted the settings as desired, click **Render**. A window will open showing blue sky. A rotating dial will appear at the top of the window to indicate that the program is busy. There are also countdown numbers on the window’s status line to indicate progress.

If you want to stop rendering before it is finished, you may either click the box to close the window, or choose **Stop rendering** from the Render menu.

When the picture is completely rendered, you may save it if desired. First make sure the picture window is selected. Then choose **Save** or **Save As** from the File menu. (If either the Map or Camera View window is selected, then **Save** and **Save As** will save the landscape and settings instead of the picture).

For more practice, you may wish to try changing some of the values in the Settings panels and view their effects on rendered images.
Tutorial: Using the Map and Camera Settings Panels

The previous tutorial showed you how to position the camera and adjust the view using only the Camera View window. You might have noticed that the lines in the Map window, which indicate the field of view, moved when changes were made in the Camera View window. The numeric fields in the Camera Settings panel are also updated to reflect the new camera coordinates.

You may use all three windows to view or modify the camera location and direction. This tutorial will give you practice in using the Map and Camera Settings panel.

If you do not currently have a landscape loaded, you will need to do so before proceeding. If this is the case, choose Open Terrain CD/DVD-ROM from the File menu. Select one of the terrain models and click the Open button.

After the terrain has loaded, click on the Map window title bar if it is not selected. Then select the Location tool by clicking its button on the Toolbar.

When you move the mouse pointer over the map, you will notice that the East, North, and Elevation values are constantly updated at the top of the window. The coordinates on the Map window’s status line describe the location of the pointer, not the camera. The elevation of the land at the location under the pointer is also shown.
If the Settings panel is not visible, display it now by choosing Settings from the Windows menu. Then click the Camera tab.

Now try clicking anywhere on the map. The camera will instantly move to the new location, and the Camera View window will show the view from the new location. The East and North camera coordinates in the Camera Settings panel will be updated to reflect the new location of the camera. If you want to go back to the previous location, click the Undo button in the Toolbar.

You may wish to click the mouse in a few other locations to see what the landscape looks like.

Now we'll change the field of view. Select the View Changing tool. Press and hold the left mouse button while moving the mouse pointer. You will see the view field lines move. For telephoto lens selection, move the mouse pointer away from the camera while holding the mouse button down (the camera is located where the view field lines meet). To select a wider angle of view, move the mouse pointer closer to the camera. To change the view direction, move the mouse pointer around the camera. When you let go of the mouse button, the program will update the Camera View window and the Camera Settings panel fields that changed.

If you wish to change the view direction without changing the field of view, press and hold the Shift key before pressing the mouse button.

Now we'll see what happens when we enter a new value in the East field in the Camera Settings panel. First click in the East field to select it. Then enter a new value that is 500 meters greater than the current value. When you press Enter, the camera will move 500 meters to the east.

Now try entering a new value in the Dir field. Enter any number between 0 and 360 and press Return. The view direction will instantly change on the map and the view will be updated in the Camera View window.

You may wish to experiment with some of the other fields. Their function should be self explanatory from their field names, however for more information see the “Tools and Windows” chapter.

Some terrain models may be larger than the displayed area of the Map window. If you want to view an area that is not displayed, select the Hand tool. Then press and hold the left mouse button while dragging the map to bring the desired area into view. If another tool is selected, you can temporarily switch to the Hand tool by pressing the Space bar. You may also move the map view by using the scroll bars, but they can move in only one direction at a time.
Magnifier tool

To zoom in on an area of the map, select the Magnifier tool. (You can also press Control + Space to select it temporarily). Then drag a rectangle around the area of interest on the map, and it will be magnified to fill the window. You can continue zooming in this way until the magnification factor reaches 512X. To rapidly switch magnification levels, or if you are lost in the middle of a large landscape, select a magnification level from the pop-up menu at the upper left of the Map window. To switch one magnification level at a time, click in the “+” or “-” buttons, which are also at the bottom of the Map window.

Lake tool

Now we'll create some lakes. First select the Lake tool. Next, click the mouse pointer anywhere over the map. You should see a lake fill the landscape at and below the point you click. You may create up to 64 lakes at a time in Natural Scene Designer Pro.

If you create a lake that you don’t want, click the Undo button, or choose Undo from the Edit menu. However, a lake cannot always be undone if you perform another function after creating it. However, you can still choose Remove Lakes from the Terrain menu, but this will remove all lakes, not just the most recently created one.

Sometimes, when changing the camera position, it may accidentally end up below the ground surface. The view in the Camera View window will look strange, with broken up polygons.

At other times the camera may be too high above the surface. Although you could correct either situation by entering a new value in the Alt (altitude) field, it is usually more convenient to click on the Drop to Ground button.

Drop to ground tool

Clicking on this button instantly moves the camera to a location 10 meters above the ground surface. Try entering either a very large or very small number in the Altitude field of the Camera Settings panel (be sure to press Return when done), and then click on the Drop to Ground button and observe the result.

There are some other tools on the Toolbar that we haven’t used yet. They will be described later.
This section describes the function of each Natural Scene Designer Pro menu. Some menus are summarized here and completely described in following chapters.

File Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Fractal Terrain...</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open...</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Open Terrain CD/DVD-ROM ...</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>1 CLSplashNSD7_Windows.nsd</td>
<td></td>
</tr>
<tr>
<td>2 CLSplashNSD6_4.nsd</td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Save As...</td>
<td></td>
</tr>
<tr>
<td>Import Grayscale DEM...</td>
<td></td>
</tr>
<tr>
<td>Import USGS DEM...</td>
<td></td>
</tr>
<tr>
<td>Import SDTS DEM...</td>
<td></td>
</tr>
<tr>
<td>Import GTOPO 30 DEM...</td>
<td></td>
</tr>
<tr>
<td>Import SRTM DEM...</td>
<td></td>
</tr>
<tr>
<td>Import TIFF DEM...</td>
<td></td>
</tr>
<tr>
<td>Import Bil DEM...</td>
<td></td>
</tr>
<tr>
<td>Import GridFloat DEM ...</td>
<td></td>
</tr>
<tr>
<td>Import ASCII Grid DEM ...</td>
<td></td>
</tr>
<tr>
<td>Import IMG DEM...</td>
<td></td>
</tr>
<tr>
<td>Export 3D DEM...</td>
<td></td>
</tr>
<tr>
<td>Export Grayscale DEM...</td>
<td></td>
</tr>
<tr>
<td>Export USGS DEM...</td>
<td></td>
</tr>
<tr>
<td>Export GridFloat DEM ...</td>
<td></td>
</tr>
<tr>
<td>Export Ascii Grid DEM ...</td>
<td></td>
</tr>
<tr>
<td>Page Setup...</td>
<td></td>
</tr>
<tr>
<td>Print...</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Exit</td>
<td></td>
</tr>
</tbody>
</table>
Create Fractal Terrain — Brings up a dialog will let you set the parameters and create a fractal terrain. See the “Terrain Models and Settings” chapter for more information.

Open — Opens a previously saved Natural Scene Designer Project file or picture. If you wish to load multiple adjacent Natural Scene Designer Project files, press the Shift or Command keys in the Open File dialog.

Open Terrain CD/DVD-ROM — Lets you open terrain models by clicking on a large scale shaded relief map. The 3D Terrain Model CD-ROM or DVD-ROM (available separately) must be in your drive.

Open Recent — Displays a list of the most recently open files for quick access.

Close — Prompts you to save the current project (if necessary) and then closes the Map and Camera windows.

Save — Saves the project if either the Camera window or the Map window is selected. If a picture window is currently selected, the picture will be saved.

Save As — Same as above, except that you will be able to enter a name for the file to save.

Revert to Saved— Lets you reload the most recently saved version of the current project.

Import Grayscale DEM — Imports a picture and uses it to create a new terrain. The intensity of each pixel is evaluated to determine the height of each point. The highest intensity pixels become the highest points in the terrain, and the darker pixels become lower points. The imported picture may be grayscale or color.

Import USGS DEM — Imports a Digital Elevation Model (DEM) from the U.S. Geological Survey.

Import SDTS DEM — Imports a SDTS Terrain model from the U.S. Geological Survey.

Import GTOPO 30 DEM — Imports a GTOPO 30 Terrain Model from the U.S. Geological Survey.

Import SRTM DEM — Imports a SRTM (Shuttle Radar Topography Mission) HGT file. These DEMs were created by NASA in 2000 for most of the earth.

Import TIFF DEM — Imports a TIFF DEM. This is one of the DEM formats supported by the USGS National Elevation Dataset.

Import BIL DEM — Imports a BIL DEM from the National Elevation Dataset.

Import GridFloat DEM — Imports a GridFloat DEM from the National Elevation Dataset. These DEMs have the most precise elevation values.

Import Ascii Grid DEM — Imports an Ascii Grid DEM.

Import IMG DEM — Imports an IMG DEM. This is one of the DEM formats supported by the USGS National Elevation Dataset.

Export 3D DEM — Exports the current landscape as a QuickDraw 3D (3DMF), 3D Studio (3DS) or DXF file. You can choose the boundary of the area you want to export, and the sample spacing interval.

Export Grayscale DEM — Exports a grayscale picture of the current terrain. The highest elevations will become the lightest pixels, and the lowest elevations will be the darkest pixels. You can use this function to modify a terrain using an image editing program, and then import it back into Natural Scene Designer Pro using the Import Grayscale DEM function.

Export USGS DEM — Exports the currently loaded terrain as a USGS DEM file.
Export GridFloat DEM — Exports the currently loaded terrain as a GridFloat DEM.
Export Ascii Grid DEM — Exports the currently loaded terrain as an Ascii Grid DEM.
Page Setup — Brings up the standard printer page setup dialog box.
Print — Prints the contents of the currently selected picture window (if any).

Edit Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo View Change</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Clear Selection</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Preferences ...</td>
<td></td>
</tr>
</tbody>
</table>

Undo — Restores the program to the way it was before you performed the most recent action. Moving the camera or changing the view direction can be undone. Changes to the camera path can be undone. If there is enough memory, terrain edits and lake placement can be undone.

Cut — If text is selected, it is saved to the clipboard and then the selection is deleted.

Copy — Makes a copy of the selected text and saves it in the clipboard.

Paste — Pastes the text in the clipboard into the currently active text field (if any).

Delete — Deletes the selected 3D object, overlay, or keyframe.

Clear Selection — Clears the clip rectangle or deselects the 3D object, overlay, or keyframe.
Terrain Menu

Terrain Info — Displays information about the current terrain.

Import Terrain Bump Map — Lets you import a terrain bump map and adjust its settings.

Terrain Bump Map Settings — Lets you adjust the settings for the terrain bump map.

Set Terrain Sample Distance — Displays a dialog where you can set the horizontal distance between terrain samples, or resample the terrain at a new interval.

Georeference Terrain — Guides you through the steps of georeferencing the terrain. This is fully described in the “Georeferencing” chapter.

Reproject Terrain — Lets you reproject the terrain. This is fully described in the “Reprojecting Images and Terrain” chapter.

Vertical Exaggeration Factor — Lets you change the vertical exaggeration factor of the terrain, which is set to 1 by default. Since the maximum allowed elevation in Natural Scene Designer Pro is 30000 meters, the scaling limits will be adjusted, if necessary, so that it does not exceed the maximum height.

You can optionally adjust the camera elevation, animation path (if any) and the elevations for terrain features and coloring. 3D objects and trees will automatically be moved vertically along with the terrain.

Smooth Terrain — Averages the elevation values to simulate the natural process of erosion. This function may be applied repeatedly until the desired effect is achieved.

Remove Lakes — Removes all lakes from the terrain.

Enter Terrain Clip Border — Lets you enter the coordinates of the terrain area you wish to be clipped. After entering the coordinates, you will still have a chance to drag the clip edges on the map.

Clip Selected Terrain — Removes all terrain outside the selected clip border.

Fill Void Areas — Fills areas with no terrain (shown on the map window as black). This function uses neighboring elevations to approximate the elevations in the void area.
Objects Menu

**Import 3D Object** — Imports a 3D object that can be placed anywhere in the scene. The program imports 3D Studio (3DS) and QuickDraw 3D (3DMF) objects. After the 3D object is imported, a small image will be added to the collection in the Objects window. Then when the small image is selected (indicated by a red frame around its border), you can place the object in the scene by clicking the mouse pointer in the Camera or Map windows.

If an object contains a texture map, it will be included in ray traced renderings and the Camera window if OpenGL is installed. However, the object will be shown in a solid color in the Object window.

**Create Tree** — Displays the Tree dialog. You can select the tree type — Oak, Palm, Redwood, or Sweet Gum. Changing the Seed yields a new tree with a unique trunk and branch structure. The leaf color, bark color, and the amount of leaf coverage are adjustable.

**Create Bush** — Displays the Bush dialog. You can adjust the settings and create a bush.

**Create Rock** — Displays the Rock dialog. You can adjust the settings and create a rock.

**Create Sphere** — Creates a sphere and places it in the Objects window.

**Create Block** — Creates a block and places it in the Objects window.
Create Cone— Creates a cone and places it in the Objects window.

Create Cylinder— Creates a cylinder and places it in the Objects window.

Properties — If an object is selected, this dialog lets you edit its properties. It contains numeric fields for the location, motion, and size. You can adjust the surface properties too. If a tree is selected, the Tree dialog is shown instead, where you can change the tree parameters.

Make Master — If an object is selected, this function creates a small image of it, and adds it to the collection in the Objects window. Once there, it is available for placing additional copies.

This function is useful when you import an object, modify it, and then wish to place additional copies without having to reapply the modifications for every copy.

Show Object / Show as Box — You can choose how you want to display the selected object in the Camera window. Complex objects with thousands of polygons can be manipulated much more quickly when they are shown as a box.

Save View — Remembers the current camera location, lens, direction, bank, and pitch.

Restore View — Restores the camera view with the previous settings.

Top View — If an object is selected, this function moves the camera to a preset position above the object.

Front View — Moves the camera to view the selected object from the front.

Side View — Moves the camera to view the selected object from the side.

Delete Object — If an object is selected in the Camera View or Map, it is deleted.

Delete Master— If an object master is selected in the Objects window, it is deleted. If the object has been placed in the scene a warning will be displayed, and you can choose to cancel or proceed with the deletion.
**Overlays Menu**

<table>
<thead>
<tr>
<th>Overlays</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Image and Scale to Fit...</td>
<td></td>
</tr>
<tr>
<td>Import DRG or DOQ...</td>
<td></td>
</tr>
<tr>
<td>Import Georeferenced Image...</td>
<td></td>
</tr>
<tr>
<td>Import Shapefile...</td>
<td></td>
</tr>
<tr>
<td>Use Displayed Image as Overlay...</td>
<td></td>
</tr>
<tr>
<td>Create Contour Map...</td>
<td></td>
</tr>
<tr>
<td>Export Selected Overlay...</td>
<td></td>
</tr>
</tbody>
</table>

| Georeference Image... |  |
| Reproject Image... |  |
| Decollar Image... |  |
| Projection Properties... |  |
| Overlay Properties... |  |
| Save Merged... |  |
| Copy GeoTIFF Tags... |  |

Move to Top
Move Up
Move Down
Move to Bottom
Delete Overlay

**Import Image and Scale to Fit** — Imports a picture and drapes it over the terrain. This function stretches the image in both dimensions to fit the terrain. So to avoid distortion, the aspect ratio of the image should match the terrain. The program will match the top of the overlay with the northern edge of the terrain, and the left edge of the overlay matches the western edge of the terrain. After importing, you can adjust the overlay image size and position using its handles shown in the map window.

**Import DRG or DOQ** — Imports a USGS DRG or DOQ and drapes it over the terrain. DRGs (Digital Raster Graphics) are digitized topographic maps. DOQs (Digital Orthophoto Quadrangles) are aerial photographs. These images typically have borders (collars) which can be removed by this function.

**Import Georeferenced Image** — Imports a TIFF file with embedded alignment information and drapes it over the terrain. This function automatically aligns the image to the current terrain if they overlap in coverage. The alignment information is expected to be embedded in GeoTIFF tags in the TIFF file, or in a separate “.tfw” or world file.

**Import Shapefile** — Imports a Shape (.shp) file and drapes it over the terrain. You can set the line and fill colors, line width, and line transparency.

**Use Displayed Image as Overlay** — This drapes the currently displayed image over the terrain.
Create Contour Map — Creates a contour map of the terrain. First, a dialog is shown to let you set the line interval, base elevation, color, transparency, and line width.

Export Selected Overlay — Exports the selected overlay as either a bitmap or shapefile (as appropriate).

Georeference Image— Guides you through the steps of georeferencing a bitmap image.

Reproject Image— Lets you change the projection and datum of a bitmap image.

Decollar Image — Lets you remove the edges of a georeferenced image by specifying the lat/lon extent. This is necessary, for example, when overlaying multiple adjacent DRGs.

Projection Properties — Displays a dialog showing the current image’s projection, datum, and other parameters.

Overlay Properties — Shows information about the selected overlay. This includes its borders, a small image of it, and overlay transparency settings.

Save Merged — This function is available if multiple terrain overlays are loaded. It allows you to combine them and save them as a picture. Among other possible uses, it’s also a good way to automatically combine adjacent topographic maps.

Copy GeoTIFF tags — GeoTIFF tags are data fields stored in TIFF files which contain georeferencing information. They describe the coordinate system, projection, datum, and projection parameters. Unfortunately, some image editing programs discard this important information when saving a TIFF image. So this function is available for you to restore the GeoTIFF tags in an image after they have been stripped out.

To use this function, you need to maintain a saved copy of the original GeoTIFF image from this program. If you edit a GeoTIFF in another program, be sure not to overwrite the original image after you are done editing — save it with a different name.

After choosing Copy GeoTIFF tags from the Overlays menu, the program will prompt you to locate the original GeoTIFF file. Then it will prompt you for the destination file where you want the GeoTIFF tags restored. This function will work only if the source and destination image dimensions are identical.

Move to Top — Places the selected overlay above all others.

Move Up — Places the selected overlay higher up in the stacking order.

Move Down — Moves the selected overlay lower down in the stacking order.

Move to Bottom — Places the selected overlay below all others.

Delete Overlay — Deletes the overlay and releases its memory.
**Path Menu**

<table>
<thead>
<tr>
<th>Path</th>
<th>Speed and Frame Count...</th>
<th>Ctrl+E</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Preview Path</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stop Preview</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Direction Tangent</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Closed Loop</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Auto Bank</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Avoid Collisions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Detect Collisions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Export Keyframes...</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Export Interpolated Keyframes...</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Import Keyframes...</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Import Interpolated Keyframes...</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Clear Path</td>
<td></td>
</tr>
</tbody>
</table>

**Speed and Frame Count** — Displays a dialog where you can enter the camera speed and animation frame count.

**Preview Path** — This function is available if a terrain model is loaded and a camera path is defined. It will play a preview of the animation in the Camera window. Also, the Map window will show the camera location and field of view as it moves along the camera path.

**Stop Preview** — Stops previewing the animation.

**Direction tangent** — Sets the camera direction tangent to the direction of travel for all animation frames. For example, it's like mounting the simulated camera to the front end of an airplane, pointing forward.

**Closed loop** — Selecting this option will allow you to create a closed loop camera path. You must have at least three key frames before the loop can be closed.

**Auto bank** — If you want the camera to automatically bank (like an airplane) when it goes around curves, select this option. This works only if the Direction Tangent option is on, and the path contains curves.

**Avoid collisions** — Activates the collision detector to automatically reposition the camera above ground when the camera path goes underground.

**Detect collisions** — Activates the collision detector to warn you when the camera path goes underground. Before the program begins rendering the animation, it will stop and give you a chance to correct the problem or ignore the warning.

**Export keyframes** — Keyframes are the control points that you place on the map. This function creates a text file describing the camera position and direction for each keyframe.
Export interpolated frames - The actual number of interpolated frames is usually much higher than the number of keyframes. They are interpolated based on the keyframe locations and the camera speed. This function creates a text file describing the camera position and view direction for each interpolated frame.

Import Keyframes - This function expects a text file describing the camera position and direction for each keyframe. Then it shows the imported path on the map.

Import Interpolated Frames - This function expects a text file describing the camera position and direction for each interpolated animation frame.

Clear path — This erases all the key frames.

Render Menu

<table>
<thead>
<tr>
<th>Render</th>
<th>Ctrl+R</th>
</tr>
</thead>
<tbody>
<tr>
<td>Render Picture...</td>
<td></td>
</tr>
<tr>
<td>Render Animation...</td>
<td></td>
</tr>
<tr>
<td>Render Shaded Relief...</td>
<td></td>
</tr>
<tr>
<td>Render Planimetric Oblique Relief ...</td>
<td></td>
</tr>
<tr>
<td>Render Viewshed Map ...</td>
<td></td>
</tr>
<tr>
<td>Render Texture Shade...</td>
<td></td>
</tr>
<tr>
<td>Suspend Animation Rendering ...</td>
<td></td>
</tr>
<tr>
<td>Resume Animation Rendering ...</td>
<td></td>
</tr>
<tr>
<td>Cancel Rendering</td>
<td></td>
</tr>
</tbody>
</table>

Render Picture — Displays the Render Picture dialog to adjust the rendering settings. Then it opens a window and renders the picture.

Render Animation — Renders an animation of the camera traveling along the defined path. First, a dialog will appear for you to choose the location to save the animation file. Next, it brings up a dialog box to set the resolution, compression, and frame range. Finally, it opens a progress display window and renders the animation, showing a view of each animation frame and estimated remaining rendering time.

Render Shaded Relief — Brings up a dialog that lets you adjust the colors and altitude ranges. Then it renders a shaded relief map of the current terrain.

Render Plan Oblique Relief — This creates images similar to shaded relief. However, instead of looking straight down, terrain is rendered at an angle of your choice, but the size is constant from front to back (or bottom to top).

Render Viewshed Map— Creates a shaded relief map showing the viewable area from any selected viewpoint.

Render Texture Shade— Creates a texture shaded map.

Suspend Animation Rendering — If an animation is in progress, this function suspends rendering. You can resume rendering later.
**Resume Animation Rendering** — Resumes an animation that was suspended. The program prompts you to locate the partially completed animation.

**Cancel Rendering** — Stops rendering the picture or animation currently in progress. Do not use this function if you think you might want to resume it later.

## Windows Menu

- **Camera View** — This function activates the Camera window and puts it in front of the other windows.
- **Map** — This function activates the Map window and puts it in front of the other windows.
- **Settings** — This function brings the Settings panel to the front and makes it the active window.
- **Objects** — Shows or hides the 3D objects window.
Natural Scene Designer Pro supports several types of terrain models. They include grayscale, USGS DEMs (7.5 minute and 1 degree), SDTS (Spatial Data Transfer Standard 10 and 30 meter), GTOPO 30, SRTM, TIFF, BIL, GridFloat, Ascii Grid, IMG, a user friendly text format (described in this chapter), and its own proprietary project file format optimized for use in Natural Scene Designer Pro.

Natural Scene Designer Pro Terrain Models

The program CD-ROM contains nearly 1000 7.5 minute (30 meter) terrain models covering a portion of California and Nevada. The CD-ROM also has a large scale shaded relief map, which makes it very convenient for loading terrain models – you just click or drag select on the area you want to load.

Adjacent 7.5 minute terrain models are automatically combined if you drag select more than one.

7.5 minute terrain models are grouped into “UTM zones”, which are spaced 6 degrees apart in longitude. Since each UTM zone uses its own reference point, and the fact that the earth is spherical, the terrain models in one UTM zone do not match up with those in an adjacent zone without special processing.

A very advanced feature of Natural Scene Designer Pro is its ability to automatically transform and combine terrain model groups that span across a UTM zone. This feature is completely transparent, so you do not have to concern yourself with UTM zone boundaries.

Each 7.5 minute terrain model requires about 1 megabyte of memory to load and render. For fastest rendering it is best to limit the number of terrain models to the minimum number needed.

Additional CD-ROMs and DVD-ROMs covering most of the world (and Mars too!) are currently available separately from Natural Graphics. Please check our website at http://www.naturalgfx.com for the most current product information.
Opening Terrain Models from 3D Terrain Model Discs

To access the terrain loading screen, first make sure that either the Program CD-ROM or one of the additional coverage CD/DVD-ROMs (available separately) is in your drive. Then click on the Open Terrain CD/DVD-ROM button and you will see a new screen with a shaded relief map.

Some DVD-ROMs contain multiple coverage areas. If so, the program will display a pop-up menu for you to choose which one you want.

The selected area is shown with white outlined boxes. Each box is a 7.5 minute terrain model.

When you run the mouse pointer over the map, the top area of the map displays the name of the 7.5 minute map and the latitude and longitude at the current pointer location. If you want only one 7.5 minute terrain model, just click on the map at the desired location. For more than one, drag-select a rectangular area.

After you have selected the terrain model(s) to load, click Open. The program will return to the main screen and load the terrain models.
The terrain models included on the program CD-ROM are a small sample of what is available separately. Please visit our web site at “http://www.naturalgfx.com” for more information.

**Terrain Information Dialog**

Choose **Terrain Info** from the Terrain menu to view information about the current terrain.

The information presented in this dialog should be self-explanatory. Note that the format of the information will differ from the example above if the terrain does not have UTM projection.

**Importing Grayscale Pictures as DEMs**

Natural Scene Designer Pro can import a grayscale picture and convert it to a DEM. Each pixel is interpreted as an elevation. The darkest pixels are the lowest elevations, and the lightest pixels are the highest elevations.

If you import a color picture as a DEM, the red, green, and blue components of each pixel are averaged to determine the elevation.
Importing Ascii Grid DEMs
Ascii Grid DEMs are simple and editable with any text editor. They contain a 6 line header followed by the elevation values. It is not a very efficient DEM format because the files are often very large and it takes longer to load them than binary files.

Combining Adjacent Imported DEMs
Multiple DEMs that are geographically adjacent may be combined. Natural Scene Designer Pro automatically detects when you import or open a DEM that is geographically adjacent to the current one. If so, a dialog box will appear and you will be given a choice to either combine the two, or just load the new DEM (replacing the current one).

Note that if, for example, you want to combine three horizontally adjacent DEMs, you cannot load the middle one last. There can never be a gap between them. Also, the DEMs must all have the same sample spacing, map projection, and map datum.

Combining large numbers of DEMs this way can be tedious. With the Terrain CD/DVD-ROMs that are sold separately you can quickly and easily combine hundreds of adjacent DEMs by drag selecting them on a map.

DEM Clipping
You can clip out a rectangular area from a larger DEM by selecting the clipping tool.

To use this tool, drag a rectangle on the map over the area you want to keep. The dimensions of the selected area are shown at the top of the map. When you let go of the left mouse button, the program will display dragging handles if you wish to adjust the area. When you are ready to remove the terrain outside the border, choose Clip Selected Terrain from the Terrain menu. If you don’t want to clip the terrain, choose Clear Selection from the Edit menu.

To constrain the selected area to a square, hold the Shift key down before you start your selection.
Creating Fractal Terrains
Natural Scene Designer Pro has a built-in fractal terrain generator that can create millions of random landscapes. Benoit B. Mandelbrot coined the term fractal, which refers to objects that are self-similar at different scales. The shape of many natural objects, including land, trees, clouds, coastlines, and plants may be described using fractals. Natural Scene Designer Pro lets you quickly and easily create fractal landscapes, without requiring familiarity with fractal mathematics.

To create a fractal landscape, choose Create Fractal Terrain from the File menu. This will display the dialog box shown above. Many parameters are adjustable, and you can quickly get a preview of the terrain to be generated.

**Terrain Size** - This lets you set the number of rows and columns.

**Sample Spacing** - You have a choice of 10 or 30 meter sample spacing. If you choose 10 meters, the terrain will have more detail than it would with 30 meters. However, for a given size area a 10 meter sample spacing uses 9X as much memory as a 30 meter sample spacing.

**Height Slider** - This controls the maximum height of mountains in the terrain.

**Feature Size Slider** - This controls the average size (in meters) of terrain features, such as valleys and mountains.

**Bumpiness Slider** - This controls the amount of small bumps in the terrain.
Octaves Slider - This controls the level of detail in the terrain. When set to a value less than 8 you will notice the terrain is simpler and smoother.

Seed - Each “seed” produces a unique terrain. There is no obvious relationship between the value of the seed and the shape of the landscape that will result. However, the same seed will always produce the same landscape. You can change the seed number and click Preview until you see a terrain you like.

Note that both the Height and Feature Size affect the resulting steepness of the terrain. Large values will yield tall, steep mountains. Lesser values will yield gentle rolling terrain. The height value can range from 0 to 30000.

Creating Terrain Models
This is for users who would like to create their own terrain models. The format described here is very simple. It will enable you to create terrain models that will load into this program. The file must be pure ASCII text (not binary data). Fields may be delimited by spaces, tabs, or a new line. Include the following in the file:

“NSDF” (four characters, all uppercase).
The number of rows.
The number of columns.
The distance between elevation samples.
The elevation samples. (The number of samples must equal the product of the rows times the columns and all elevation values must be integers between 0 and 9999.

The first elevation sample represents the northwest corner of the landscape. The next value represents the location to the east of the previous one. And so it goes, until you get to the end of the row. Then you start the next row, which is south of the previous row.

Example text file:
NSDF
4
5
30
10 10 10 10 10
10 20 20 20 10
10 20 30 20 10
10 10 10 10 10

Choose Open from the file menu to load the file into Natural Scene Designer Pro.
World Settings

The World Settings panel allows you to specify whether to use a planar or spherical earth model. For small and medium areas, selecting ‘Plane’ is usually best. It's the fastest option of the two.

If you are viewing a very large area from a high altitude and want to have the earth’s curvature visible along the horizon, select ‘Sphere’. Scenes render more slowly in this mode.

For the background, your choices are a sphere or nothing (as feared by ancient sailors!). If you choose “Earth Sphere” you can set the radius, or use the default value of 6370997 meters, which is the actual radius of the Earth. You can also set the color of the sphere. The sphere elevation is its distance above sea level.

The Ocean Level and check box in this dialog are the same settings as in the “Water” dialog. They are duplicated here for your convenience.

A field for entering the Atmosphere thickness (in meters) is available.

Note: The program uses the Atmosphere thickness value only when the earth model is set to ‘Sphere’ and the camera is above the atmosphere (such as when you are rendering an image of the entire globe).
The Terrain Settings panel has a preview window and a choice of two terrain coloring methods. You can choose to have the terrain colors blended according to the elevation. Or you can have the terrain features colored according to slope, elevation, and fractal texturing. This choice is made using the radio buttons in the “Terrain Coloring Method” box.

When using colors blended according to elevation, you can set the “Blend Amount” slider. Transitions from one color to another can be abrupt (0% blending), or very gradual (100% blending). For convenience, there is a popup menu with some preset color combinations, and another popup for setting the color distribution. You can use the color sliders, numeric fields, or color distribution menu to adjust the color break elevations.

When using terrain features coloring method, part of the dialog changes as shown in the illustration at right. The Palette, Color Distribution, and Blend Amount are not available in this mode.

Click on a color square to change a feature's color. To the right of each selection box, except **Soil**, is a numeric entry field. This is where you enter the elevation for that feature. For **Snow** and **Rock** it is the desired approximate minimum elevation. It is the maximum elevation for **Grass**. **Soil** is a special case; it appears by default at locations where snow, rock, and grass are absent.

If you have chosen to use the “Feature” coloring method in the Terrain Settings dialog, you can click on the Snow, Rock, Grass, and Soil buttons. This brings up the “Terrain Texture” dialog for that
feature, as shown below. Soil and Grass have a choice of two texture types -- Fractal or Texture map. Rock and Snow only use a fractal texture.

If you choose “Fractal” you can adjust the texture **Amount**, **Size**, **Contrast**, and **Color** settings as desired. With the immediate feedback in the preview square, you can readily learn the effect of each adjustment.

If you select “Texture map”, the program uses a built-in photo texture map and no parameters are adjustable.
Bump Mapping

Bump maps can be used to add detail to the terrain to make it look more realistic. The program interprets the grayscale value (or brightness) of pixels in the bump map to simulate small displacements.

To import a bump map, choose Import Terrain Bump Map from the Terrain menu. After selecting the file to open, click Create new bump map in the Import Bump Map dialog. You also have other options, such as tiling the bump map, georeferencing it, or adding it to an existing bump map (if already present). After choosing the options you want, click Create new bump map (or Add to existing bump map). Then you will see the dialog shown below.

Click Preview or Map to see what the bump map looks like applied to the terrain.

You can set the minimum and maximum elevations of where you want the program to apply the bump map. To avoid a harsh transition where the bump map starts and ends, you can specify the transition range (in vertical meters) for the bump map to be phased in and out. You can also specify the range of the slope (in degrees) where you want to use it. The transition

The Bump Displacement field sets the vertical magnitude of the bumps. This may require experimentation to get the amount you want.

To be effective, bump map images should have a much higher resolution than the terrain. You can use random grayscale textures as bump maps. Another good choice are DOQs or high resolution satellite imagery. If you use a color image as a bump map, the program will calculate the brightness of each pixel to determine the bump displacement. However, to conserve RAM it’s better to convert the bump map to grayscale first.
Vertical Exaggeration
To emphasize vertical features, or to bring out detail from relatively flat terrain models, you can use the vertical exaggeration setting. A value of less than 1 will flatten the terrain, and a value greater than 1 will make it steeper. Note that changing this setting does not alter the stored terrain, so you can change the vertical exaggeration an unlimited number of times without loss of vertical precision.

![Vertical Exaggeration Dialog Box]

You may also choose to adjust the camera and path altitudes to correspond with the change in vertical exaggeration.

Bitmap Terrain Overlays and DRGs
Terrain overlay pictures, GeoTIFFs and DRGs may be imported into Natural Scene Designer Pro and draped over the terrain, replacing the program generated texture that is created by default. The program supports multiple overlays with full control over position and layering order. A Mars terrain with a matching overlay, courtesy of NASA's JPL, is included with this program.

To load a terrain overlay, select either Import Image and Scale to Fit, Import DRG or DOQ, or Import Georeferenced Image from the Overlays menu, depending on the type of overlay. You may also select Use Displayed Image as Overlay if an image is currently loaded in the Picture window. These functions process overlays differently, as explained in the next sections.

Import Image and Scale to Fit
This function simply takes an image and spreads it to the edges of the terrain. To avoid distortion, the aspect ratio of the picture should match the terrain. The program will match the top of the overlay with the northern edge of the terrain, and the left edge of the overlay matches the western edge of the terrain. After importing, you can adjust the overlay size and position using its handles in the map window.
Import DRG or DOQ

To use this function, a GeoTIFF picture with embedded alignment information or an accompanying “.tfw” file is required. It must be in the “UTM” or “California Albers” projection, otherwise you will need to use the Import Georeferenced Image function described later, which lets you georeference and reproject an image before overlaying it onto the terrain.

Import DRG or DOQ automatically aligns the picture to the current terrain if they overlap in coverage. Once you have selected the file to load, a dialog will be shown. It contains information about the DRG, including the lat/long range of coverage and the UTM zone.

Some DRGs cover an area that is shifted from its expected area of coverage, which is derived from its alignment information. If Natural Scene Designer Pro detects a coverage shift, it will scan the DRG image and search for the thin black line surrounding the map coverage area. The coverage lat/long as determined by the program is shown in the DRG dialog. If it is incorrect (which might happen if the border is ambiguous) you can click the “Adjust Border” button and manually enter the correct lat/long boundary. Note that this does not affect where the DRG is centered on the terrain, it only changes the section of the map white border that will be clipped off.

The Import DRG dialog lets you adjust the resolution of the DRG, which is set to 50% by default. The dialog shows the resulting image size in pixels and memory usage.

If the DRG does not match the projection and datum of the current terrain, this function will automatically convert the DRG to match it.

In some cases, you might want to set the Remove line at edges checkbox, especially if you combine adjacent images.
To mask out unwanted areas of an overlay, you can define a color to be transparent. These transparent areas, when rendered, will either show the underlying terrain or the overlay below it in the stacking order (if any).

There are two ways to define a transparent color. You can either click the color box and enter it manually, or click “Pick Transparent Color” and use the tool to choose the color in the overlay preview. You can also specify a color tolerance so that similar colors will also be considered transparent.

**Import Georeferenced Image**

This is the most versatile image overlaying function. If necessary, it will handle images that have not been georeferenced. Then if the projections don’t match it will reproject the image to match the terrain’s projection. Finally it will drape it over the terrain. If you already have loaded a georeferenced image that matches the projection and datum of the current terrain, then choose **Use Displayed Image as Overlay** instead of this function.

After loading an overlay it will be shown in both the Map and Camera windows. You can reposition the overlay by selecting it using the **Arrow** tool and dragging the red overlay handles on the Map window. This should not be necessary with DRGs. They are locked to prevent accidental movement. To unlock an overlay or numerically adjust its position, use the **Overlay Properties** function.

If you have loaded adjacent overlays, you can combine and save them as a picture using the **Save Merged** function. It’s useful for automatically combining adjacent overlays, such as topographic maps.

Other functions in the **Overlays** menu let you delete an overlay or adjust its vertical stacking order, if multiple overlays are loaded.
Importing Shape Files
Choose **Import Shapefile** from the Overlays menu to bring up the Shape Settings dialog box.

You can adjust the line width, color, and transparency. If the shape is filled, you will also be able to adjust the fill color.

**Overlays Panel**
The Overlays panel lists all loaded overlays. Note that shapes always appear above bitmap overlays, and there is a solid line between them.

Select an overlay or shape by clicking on its name. It will be highlighted. Then you can move it up or down in the list using the **Move Up** and **Move Down** buttons. You can toggle it between shown and hidden with the **Show/Hide** button. Hidden items are indicated by light gray text. The **Properties** button brings up the items Properties settings. Use the **Export** button if you wish to save the overlay as a bitmap or shapefile, as appropriate. And the **Delete** button removes the item from the overlay list (but not the file on your hard drive).
The sky color blend bar has sliding adjustments for color breaks. The bottom of the bar corresponds to an angle of 0 degrees (the horizon). The top of the bar is for 90 degrees (straight up). You can adjust the angles where color breaks occur using either the sliders or numeric fields. Click in a color square to change the color.

For added convenience, several preset color schemes are available from a popup menu. The choices are Simulation, Daytime, Sunrise, Sunset, High Altitude, Desert, and Globe. Selecting one of these sets the colors and break angles appropriately. If you select one of the preset color schemes and then make adjustments, the popup menu will change to “Custom”.

“Simulation” is a special case. It uses a physical lighting model based on the lighting angle, haze, and sky brightness. It ignores the colors and break angles in this mode. You should not adjust the colors or break angles when “Simulation” is selected -- otherwise it will revert to your custom color scheme.

If you want to immediately see the effects of your adjustments, select “Automatic Preview”.

You can adjust the brightness of the sun and sky using the two adjustment sliders. The sun color is also adjustable, and you can choose whether or not to render it.

There are two adjustments for haze. You can adjust the amount of haz using the slider control. The ‘No Haze For’ field is for entering a distance (in meters) from the viewpoint where there will be no haze. This lets you render the foreground unobstructed by haze.

You can save your favorite sky settings for use in other projects by clicking Save Sky Settings.
Clouds

The Sky Settings dialog has adjustments for Cirrus and Cumulus clouds. They can add dramatic effects to landscapes. There are separate groups of settings for each cloud type.

The Density slider lets you enter the percentage (0-100) of cloud cover. Zero percent specifies no clouds and 100% would create complete cloud cover. You can, of course, enter any value in between.

The Altitude slider controls the average cloud altitude. A value of 4000 here is usually best.

Clouds may be given a direction and speed for animations. The Dir field is their compass direction of travel. The Speed slider controls how far they travel between successive animation frames.

The Seed field lets you select completely different cloud patterns. It controls a random process, and there is no easily predictable relationship between the seed number and the resulting cloud pattern, however, the same seed will always produce the same cloud pattern. The seed must be an integer.

Tutorial: Animating Clouds

First, load any terrain. Then clear all the key frames, if any, by choosing Clear path from the Path menu. Select a wide angle value (18 to 35) for the camera lens using the Lens field in the Camera Settings panel. Now position the camera anywhere in the landscape. We need to aim it above the horizon so that a major portion of the sky is visible. The Hand tool is convenient for aiming the camera.

Select the Hand tool and grab the image in the top of the Camera window. (It might be easier to press the Space bar to temporarily switch to the Hand tool). Then drag the preview image down (the view will aim upward).

Choose the Sky tab on the Settings panel. Select a density of 50% for cirrus clouds, and 25% for cumulus clouds. An altitude of approximately 4000 should work well for both cloud types. Set both speed sliders to any value between 100 and 500. This specifies the number of meters that the clouds will move between animation frames. Set the Dir field to 90 for both cloud types so that they will move eastward. Choose any value for the seed. Each seed number will generate a unique cloud pattern.

In the Path menu, turn off the Direction tangent option. This will prevent the animation processor from altering the camera direction.

Now we will create two key frames, since all animations require at least two, even when the camera is not moving or changing direction.

Select Speed and Frame Count from the Path menu. Enter 50 in the Total Frames field. Click OK.

Now choose Render Animation from the Render menu. Enter the name of the animation file and click Save. Clouds are not shown in Quick Test mode, so be sure to select the Ray Trace rendering method in the Animation dialog. Choose an image size and click Render to begin rendering the animation. When rendering is complete, you can choose Open from the File menu or use a movie player program to view it.
Water Settings

Choose the Water tab on the Settings panel to adjust the wave height, reflectivity, water color, and ocean level.

Oceans flood the entire landscape at or below the level you specify, as opposed to lakes (created using the Map window), which only fill isolated areas. An ocean will appear if the Ocean check box is selected and the water level is above land at some point. You can raise or lower the ocean level without permanently altering the landscape.

The Wave Height slider lets you specify the average vertical distance from the wave peak to the trough. Water scenes usually look best when the camera is positioned between 2 and 10 meters above the surface. The percentage reflection of water varies depending on the viewing angle. Water reflects the least amount when you look straight down on it. It reflects the most when viewed at a shallow angle (or from far away).
Trees
Natural Scene Designer Pro contains a built-in tree generator which can create realistic trees to enhance your scenes. You can create trees and individually place each one, or use the background tree generator to automatically position large numbers of them according to your placement specifications.

Four types of trees are available — Oak, Palm, Redwood, and Sweet Gum. It's easy to create and place a tree.

First, choose Create Tree from the Objects menu. When the dialog appears, select the type of tree you want. Then you can adjust the bark and leaf color, the leaf percent, and the seed.

The Seed value initializes a random number generator. Each seed will produce a unique trunk and branch structure. You can either enter a numeric value directly in the Seed field, or click the New Seed button to have the computer choose a seed for you. Click the Preview button to see what the tree looks like. After a few seconds a miniature tree picture will appear in the preview box. When satisfied with your new tree, click OK.

The Size value is 100% for average size trees. A value of 300% would yield a tree 3 times the average size.

The program will generate the tree and then add a small image of it to the collection in the Objects window. To place a copy of the tree in your scene, select the tree's small image in the Objects window. The selected small image should have a red border frame. Now click the mouse in the Map or Camera window at the location where you want to place the tree. Note that if you click on the sky in the Camera window, nothing will happen.

To place multiple copies of the same tree, double-click its small image. This “locks” the tree object tool until another tool is selected. If you single-click on the small tree image, you can place one tree and then the program will automatically revert back to the Arrow tool.

You may create as many trees as you have memory for. Each unique tree uses about 1 MB of memory. For example, creating 5 different trees and placing 1 copy of each would about 5 MB of memory, but placing 5 copies of the same tree would use about 1 MB.
Background Trees

It would be tedious to manually place large numbers of trees in a landscape scene. Instead, you can use **Background Trees**, which are automatically placed in the scene within the elevation range you specify. Oak, Redwood, and Sweet Gum trees work well as background trees. Palm trees have long, narrow trunks which don’t show up very well when viewed from far away. You can create up to four unique background trees, each of which may appear in the scene thousands of times.

To setup a scene with background trees, choose the **Trees** tab on the Settings panel. The panel has four groups of settings. Click **New Tree** to create a new background tree. Then you'll get the same dialog as described previously for regular trees, except that the “Export 3DS” option is not available for background trees. (To export a 3DS tree you need to use the “Create Tree” function in the “Objects” menu). When you have entered the parameters for the new background tree, click **OK** and a small image of it will appear in the Background Trees dialog. You can set the elevation range where trees will be placed in the scene. The **Density** slider lets you adjust the percentage of coverage. At 100% density trees are placed as closely together as possible where the slope is not too steep. Setting the density to a high value will increase the rendering time, especially if the terrain covers a large area. If you set the percentage to 0, no trees will appear.
Use the Size and Color variation controls to increase the variety of trees in the scene. At zero variation, all trees will be the same. The variation becomes more noticeable as you increase these settings. With the color variation set high, trees will vary between green and brown. Note that these two settings do not affect the shape of the tree. To do so, click the New Tree button and create a tree with a different seed value.

Background tree images are shown in the Background Tree dialog and also the Objects window. This feature allows you to conserve memory by reusing the same tree for both background use and manual placement.

Background trees are placed at randomly selected locations. The program simulates natural processes, and avoids placing them on very steep terrain and in water. It also avoids placing them where there are other 3D objects.

The background tree settings in this dialog work in combination with the background tree map editor in the Map window (as described in the next section. To use painted areas for trees, set the tree placement to “Use tree map only”. Or you can have the program ignore manually painted areas by setting tree placement to “Within elevation range only”. Then it will only use the elevation rules, and not the painted areas.

There are two other choices for tree placement. If you want background trees only in painted areas that are also within the selected elevation range choose “Within elevation range and on tree map”. Or you can do the opposite and exclude the painted area from consideration for trees. This could be useful, for example, if you are modeling a golf course or ski run where trees have been cleared out of the way. In these cases, the painted areas would represent golf fairways or ski runs.

Since background tree rendering can be time consuming, you can set the maximum distance in meters (from the camera) to render background trees. The default value of 5000 should work for most pictures. You might want to set it much higher for high altitude renderings (where trees are visible from far away) or for animations. Also, the rendering time increases proportionally to the tree density and the total number of background trees in the scene.
Background Tree Map

Click the Load Tree Map button on the Tree Settings panel to display the dialog shown above. This lets you load a tree map and determine which color(s) are used to represent trees. The original loaded image is shown on the left side, and the resulting tree map is shown on the right, with green representing where background trees will actually be placed.

The background tree map dialog is very powerful and gives you maximum control. It displays immediate feedback for all of the settings. The controls are mostly self explanatory but are fully described below.

There are two background tree mapping methods – **Use selected color(s)** and **Use pixel intensity**. The first method lets you choose one or more colors from the source image that designates trees. The second uses the pixel intensity (or grayscale value) to determine the probability that a tree will be placed in a given spot. Using the pixel intensity mapping method, white pixels have the most likelihood of producing a tree, and the probability drops as the pixel gets darker. Or you may reverse the effects of white and black by checking the Invert Map checkbox.
To select a tree color from the source image, you may either click the color square or select it from the source image by moving the mouse pointer over the desired color. For additional colors (up to 8), click the **New Color** button and then either use the ‘eye dropper’ tool in the source image or the color selector. After selecting a color, you will see instant feedback in the image on the right side of the screen showing (in green) where trees will be placed.

If the tree map image has an alpha channel, you will be given a choice of whether or not to let it affect the density of background trees.

The **Tree Color tolerance** slider lets you adjust the amount of variation from the selected color(s) where trees will be placed. For example, setting the tolerance to zero means that trees will only appear where the source image pixels match exactly, but increasing the tolerance allows more variation from the selected color(s).

The **Density** slider changes the number of trees in the green areas. The **Edge Fade** slider softens the transitions from green to white along the edges.

The **Tree Map Location** radio box gives you a choice of scaling the tree map as necessary to cover the entire terrain, or you may georeference it.

For maximum realism, georeferenced satellite photos work well for background tree maps. You can nearly match the real world tree locations. And you may combine georeferenced satellite photos, as necessary to cover the entire scene, by clicking the **Add to existing tree map** button.

Digitized topographic maps (DRGs) are another good source for background tree maps. Most of the United States is available for free download. Please see the ‘Sources’ appendix for details.

If you wish to manually edit a tree map, you may do so using the background tree map editor as described in the next section.
Background Tree Map Editor

The lower left corner of the Map window contains three little buttons to select the mode.

The tree button activates background tree painting mode. You use this mode to “paint” on the map where you want background trees to appear in your scene. To paint areas with trees, use the paint brush tool as described in the “Terrain Editor” section. To clear an area, use the eraser tool.

Bushes

Bushes add detail and a more natural look when placed in the foreground of your scene. You can place them on the ground surface, or you can use the Arrow tool in the Camera window to move them partially underground. This creates the appearance of many smaller bushes.

Seed - The seed gives each bush a unique shape. Different seeds yield different bushes. You can either click the New Seed button for a computer selected seed, or choose the seed yourself by typing it into the seed field. It must be an integer number.

Size percent - The Size value is 100% for average size bushes.

Leaf percent - This controls the percentage of twigs that have leaves. Enter a value (from 0 to 100 percent). Zero percent will yield a dead bush with no leaves.

Branch / Leaf color - Click in these boxes to set the branch and leaf color.

Preview button - Click this button for a preview of the bush.

Export button - To export the bush for use with other 3D programs, press the “Export” button.
Rock Generator
The rock generator in Natural Scene Designer Pro can create a wide variety of rocks.

You have control over several parameters, including shape, texture, size, color, and smoothness. In addition, you can change the dimensions of the rock after it's been created and placed in the Camera window. You can adjust the reflectivity and the amount of highlighted area using the **Object Properties** dialog.

To create a rock, you must first open a terrain or create a new fractal terrain. Then choose the **Create Rock** item in the Objects menu.

**Frequency slider** - Controls the size of the major features of the rock. A low value will create a relatively round rock. A high value will create a rock with lots of small spikes. A good starting value to use is 50.

**Amplitude slider** - Controls the amount of displacement for the rock features (from the center of the rock outward). A low value will make a round rock. A high value will make a very rough rock. A good starting value to use is 32.

**Steps slider** - Controls the rock's level of detail. A low value will create a smooth rock without fine details. A high value will create a more detailed rock. A good starting value is 8 (which is the maximum). For rocks that will be in the distance, you might want to use a lower value to avoid aliasing.

**Seed** - The rock seed gives each rock a unique shape. Different seeds yield different rocks.

**Radius** - Controls the average radius of the rock (in meters).

**Smooth edges** - When this is not set, the rock will have a faceted appearance up close. Turning on this option eliminates the facets.

**Export button** - To export the rock for use with other 3D programs, press the “Export” button.
Rock Texture

Click the Texture button in the Create Rock dialog to display the Rock Texture dialog. The texture consists of two colors. The program automatically displays a preview whenever you change any of the settings.

Amount slider - This controls the amount of background color used in the texture. A value of 0% creates a solid color texture (without any background color). A value of 100% uses the most background color.

Size slider - This lets you adjust the size of the texture features. A low value will create a grainy texture. A high value creates more of a marbled appearance.

Contrast slider - Controls the amount of blending between the main color and the background color. A low value yields the most blending. A high value has the least amount of blending (which is higher contrast).

Color / Background color boxes - Click in these squares to change the texture colors.

When you first start Natural Scene Designer Pro, the default settings for the sliders are Amount 38, Size 3, and Contrast 8. The main color is gray and the background color is black. These settings yield a granite texture.
Exporting Terrain

You can export terrain from Natural Scene Designer Pro for use with other 3D programs. Choose Export 3D DEM from the File menu to bring up the dialog.

The terrain may be saved as a 3DMF, DXF, or 3DS file. 3DMF and DXF files each have two save options. Other 3D programs vary in the type of file that they work best with, so it may require experimentation to determine which format works best with your 3D program.

The sample spacing determines the resolution of the 3D file. Lower sample spacings produce more realistic results, however memory and disk usage may be a limiting factor.

You can select whether of not you want a color map generated along with the 3D file. The pixel dimensions of the color map are adjustable.
Light Settings

The Light Settings panel, lets you control the lighting angle, ambient light, and shadows. You can also set the light according to the date and time.

The large and small circles in the panel graphically indicate the lighting direction and angle. The large circle represents the earth. The small circle represents the position of the sun. The center of the large circle corresponds to the sun’s position when it is directly overhead. The edge of the large circle represents the horizon; place the little circle there to simulate sunrise or sunset.

The Light Settings panel displays the numeric values for the compass direction and horizon angle. You have a choice of setting the direction and angle of the sun by locating it with the mouse pointer, or by entering numeric values. Changing the sun location with the mouse affects the numeric display, and vice-versa.

The Ambient light percentage slider controls the amount of light coming from all directions. Outdoor scenes usually look good with ambient light set at between 15 and 30 percent. Higher percentages can be used to simulate a heavy overcast.

The Shadows check box determines whether or not there will be shadows. They appear very dark when the ambient light percentage is low. The Quick Test rendering mode and the preview in the Camera window do not include shadows. They only appear in ray traced scenes.

Most landscapes look best with side lighting (relative to the camera view), and they appear flat and two dimensional with direct overhead or frontal lighting. The lighting angle is often the most important setting affecting the quality of pictures rendered by Natural Scene Designer Pro.
You can set the month, date, and time and have Natural Scene Designer Pro calculate the sun position and lighting direction. This function is accessed through a button in the Light Settings panel. If you change the sun position manually in the Light Settings panel, it will override the Date and Time dialog.
Multiple Lights

Bringing out the key features of terrain models often requires more than one light, especially when the terrain has a mountain range or ridge with a significant degree of curvature as viewed from above. Natural Scene Designer Pro lets you place a nearly unlimited number of lights over the terrain. As you can see in the above examples of Mt. Haleakala on Maui, much detail is lost with a single light when compared to the multiple light shaded relief on the right.

The **Multiple Lights** button in the Light Settings panel will bring up a dialog with controls for placing, adjusting, and quickly previewing the effect of light additions and adjustments. The multiple light dialog is also accessible by pressing the **Light** button in the **Render Shaded Relief** and **Render Plan Oblique** dialogs.

In addition to shaded relief and plan oblique, relief multiple light sources are also supported in ray tracing, animation, and spherical panorama rendering. The camera preview and quick test rendering modes do not support the use of multiple lights to save processing time.

Before discussing the use of each button and setting in the multiple light dialog, some definitions and a basic overview of how it works should be helpful.

The **Azimuth** is the compass direction of where the light is coming from. The **Elevation Angle** is the angle of the light source, with 0 at the horizon and 90 as straight overhead. The **Default Light Source** is used in shading the terrain only if no lights have been added. Once a light has been added, the default light is disregarded in shading calculations. However, it is still useful here because each time you add a light, the starting values of its azimuth and elevation angle are copied from the Default Light Source.

The lights you place are not like spotlights, which would only affect a relatively narrow field of view in front of them. Instead they affect the lighting of the terrain which lies in their vicinity. While rendering, Natural Scene Designer Pro interpolates the light direction using several of the lights closest to the patch of ground being shaded. The light azimuths are blended in such a way to minimize any abrupt changes that would cause visible shading discontinuities (artifacts). While it is possible to set up lights that will still create visible shading artifacts, they can usually be avoided by not varying the azimuth of the lights you place by more than about 120 degrees. This is especially important for lights which are placed close together.
In the multiple light dialog shown above, the light circle controls used for the **Default Light Source** operate in a similar matter to the light circle described in the previous section covering the Light Settings panel. The three **Light Source Tools** let you add, adjust, and show the interpolated light azimuth as you run the mouse pointer over the map.

The currently selected light is shown in red. You can numerically change the azimuth and location of that light in the numeric fields below the tools. But it's usually easier to select the **Adjust** tool and drag the light circle at the base, or at the light arrow tip.

Dragging the red circle at the base of the selected light changes its location. To change the azimuth and elevation angle, drag the arrow tip. The elevation angle is determined by the distance of the arrow tip from the center. When the arrow is farthest away from the center, the elevation is set to a low value. Moving it closer to the base raises the elevation angle. You can temporarily lock the elevation angle by pressing and holding the **Shift** key while dragging the arrow tip. To lock the azimuth press...
and hold the **Control** key. As you move the arrow tip or the circle at the base of the light, the numeric values for the selected light will be updated continuously.

The **Preview**, **Delete Selected Light** and **Delete All Lights** buttons on the right side of the dialog are self-explanatory. While adding and adjusting lights you will probably use the **Preview** button a lot.

The **Add** tool lets you create a light when you left-click the mouse pointer over the map. The new light’s azimuth and elevation angles will be copied from the default light source box. For this reason, if you want several new lights that are generally have the same azimuth, you should adjust the default light source before adding the lights. They can, of course, be fine tuned to different directions later.

The **Adjust** tool has two functions: changing the location by dragging the center dot, and changing the azimuth and angle by dragging the arrow tip.

After you have placed at least 2 lights, the **Show Directions** tool will visually show you the interpolated azimuth and elevation angles. Just select the tool and run the pointer over the map where you want to see the interpolated angles. The numeric values of the angles are displayed above the map.

Placing multiple lights over the terrain to achieve the desired lighting is an interactive process and will usually require many adjustments and frequent use of the **Preview** button and the **Show Directions** tool. In general, it is often easiest to start by adjusting the default light source and then adding the lights that will generally be in that direction. Then, as necessary, adjust the default light source and add more lights. (As stated earlier, please remember that once lights have been added to your project the default light source does not affect the terrain shading. It is just there for your convenience for placing multiple lights in the same general direction).

If you click **Preview** and notice a shading discontinuity somewhere on the map, it can usually be eliminated by adding a light in that area. If you are wondering why there is a discontinuity to begin with, the Show Directions tool should give you an idea of what is happening. When you run this tool over a discontinuity, you will notice a quick change in direction over a small distance.

**Important:** Once you have added one or more lights and dismissed the multiple light dialog, the changes you made are not shown on the map view or the Camera preview. To save processing time, those terrain views always use the default light direction. However, you can always use the **Ray Trace** button in the Camera preview to show the correct lighting.
Natural Scene Designer Pro offers several rendering methods including pictures, masks, panoramas, shaded relief, plan oblique relief, texture shading, viewshed maps, and contour maps. These are all available from the Render menu.

Rendering a picture
When you have set the camera location, composed the view and adjusted the settings as desired, choose Render Picture from the Render menu to create a picture.

The Render Picture dialog lets you set the size, resolution, rendering mode, and anti-aliasing setting of the renderer. The DPI in the Resolution field lets you adjust the number of pixels per inch.

The Size menu has many preset size options, along with a Custom choice for you to enter any size desired. The Units menu has three choices — Inches, Centimeters, and Pixels.

There are seven rendering modes — Quick Test, Ray Trace, Shadow Mask, Distance Mask, Height Mask, Sky Mask and Spherical Panorama.
**Quick Test Rendering**

The *Quick Test* mode renders the terrain as a faceted triangular mesh. The sky is a solid color, and clouds, background trees, shadows, reflection, texture, anti-aliasing, and haze are not included.

Individually placed trees are represented simply as basic cylinders, cones, and spheres, just to show you where they are placed. 3D objects are rendered without edge smoothing and textures. The Quick Test renderer is intended only to show you the view composition and object positioning.

**Ray Tracing**

For your final rendering, choose *Ray Trace*. An anti-aliasing setting of 3 or 4 usually represents the best trade-off between rendering quality versus time. An anti-aliasing value of 0 specifies no anti-aliasing. Set the slider to 7 when you want the maximum amount.

The *Maximum Levels* slider lets you set the maximum number of times each ray can reflect or refract. Reducing the value below 10 can save time in scenes with lots of reflective surfaces, but it may yield unusual results if set too low.

Click on the ‘Brightness / Contrast’ button to bring up a dialog for adjusting the image. You can fine tune your adjustment with a real-time preview.

After you adjusted all the settings, click *Render* to begin rendering the picture. If you want to discontinue rendering before it has completed, choose *Stop rendering* from the Render menu or close the rendering window.
When the picture has finished rendering, you can save it to disk by choosing Save As in the File menu. Be sure the picture window is selected before you use the Save As menu command, otherwise Natural Scene Designer Pro will save the landscape and settings instead.

**Shadow Mask**
This rendering mode displays all shadows as black.

![Shadow Mask](image)

You can use this mask in an image editing program to alter the look of shadows.

**Distance Mask**
This rendering mode creates a grayscale image. The shade of gray is based on the distance from the camera. The foreground renders as black and the most distant areas of the scene are white, with gradually changing shades of gray in between. The sky is white.

![Distance Mask](image)

This rendering mode can be used to add special effects in an image editing program. You can combine a normally rendered image with a distance mask to create special effects.

**Height Mask**
A height mask is a grayscale image where the shade of gray is used to represent the elevation. The lowest areas are black and the highest areas are white.

![Height Mask](image)
You can combine a normally rendered image with a height mask in an image editing program to blend in another image or apply special effects.

**Sky Mask**
This rendering mode simply renders the sky white and the terrain black.

You can use this mask in an image editing program to merge a terrain rendering with a background sky photograph.

**Panorama**
This rendering creates a full 360 degree spherical panorama. It works best when the width is twice the height, since it covers a 360 x 180 degree field of view.

There are several web based and stand alone spherical panorama viewers available for computers, tablets, and phones. For a full list, please see http://wiki.panotools.org/Panorama_ viewers. You will need a viewer which supports spherical panoramas (also known as “equirectangular”). Most of them support this type of panorama.

**Transparent Sky**
When you check the Transparent Sky option, the program will create an image with a transparent sky using the “alpha” channel. When using this option, you should save the image as a TIFF file to preserve transparency. You could use this option to add a sky photograph to the background in an image editing program.

Transparent sky is shown in Natural Scene Designer as light gray and white vertical stripes. Transparent areas will probably be indicated differently in other software.
Shaded Relief Maps
When a terrain model is loaded, choose **Render Shaded Relief** from the Render menu to bring up the dialog.

Many settings are adjustable to create a wide range of shaded relief maps. You can adjust the altitude range for each color using the triangular vertical sliders. Or you can enter a numeric value in the corresponding elevation field.
You can control the amount of blending between color transitions. This elevation based blending can be sudden (at 0% blending) or gradual. The **Preview** button will show the resulting shaded relief map.

Several preset color palettes are available via a dropdown menu. You have a choice of Default (as shown above), Atlas I, II, III, and IV, Green, Brown, Gray, and White. Or you can create your own custom palette and save it in a file. If you click on a color square you can adjust the color.

The **Color Distribution** menu offers several schemes for setting the color elevations. There are six distribution methods. 

**Equal Relative** - Spaces colors at equal intervals. Colors are set between the lowest and highest elevations in the terrain.

**Equal Absolute** - Spaces colors at equal intervals. Colors are set every 500 meters starting at 0 (sea level).

**Arithmetic Relative** - Spaces colors at increasing intervals according to an arithmetic progression. Colors are set between the lowest and highest elevations in the terrain.

**Arithmetic Absolute** - Spaces colors at increasing intervals according to an arithmetic progression. Sets colors starting at 0.

**Geometric Relative** - Spaces colors at increasing intervals according to a geometric progression.

**Geometric Absolute** - Spaces colors at increasing intervals according to a geometric progression. Sets colors starting at 0.

The Shading Amount slider controls the shading contrast. A value of 100% is the default setting. Flat areas might look better with values above 100% to help bring out the terrain’s features.

You might wonder why there is a check box for **No Shading**. This can be used to create a color map for use as a terrain overlay. You can edit the color map in a painting program, add roads, names, etc. and then import it back into Natural Scene Designer Pro as a terrain overlay.

To zoom in to a selected portion of the map, drag select an area in the preview. This will limit rendering to the zoomed area. To go back to the full map, click the **Zoom Out** button.

Click on the **Brightness / Contrast** button to bring up a dialog for adjusting the image. You can fine tune your adjustment with a real-time preview.

The width and height of the final rendered map are adjustable. Select **Constrain Proportions** to maintain the aspect ratio. You can also select whether or not to include terrain overlays in the shaded relief.

Use the **Preview** button to fine tune your settings. If you wish to retain the settings for use with other projects, use the **Save Settings** button. Then you can reload the same settings later as needed.

When you save the shaded relief map, the **Save File** dialog you will have an option to create a “TFW” file which contains alignment information necessary for automatically matching it to a DEM.
Plan Oblique Relief Maps
This creates images similar to shaded relief. Terrain is rendered at an angle of your choice, but the size is constant from front to back (or bottom to top).

Choose **Render Plan Oblique Relief** from the Render menu to bring up the dialog shown above. The settings for planimetric oblique relief are nearly identical to the shaded relief settings previously described. Please refer to that section for a description of all the parameters. The additional **Pitch** field lets you control the viewing angle. The allowable range is -89 (almost looking straight down), to -19 (looking at a shallow angle).
Viewshed Maps

You can make a map of areas that are visible from any given viewpoint. The viewpoint and either the viewable area or the hidden area can be indicated by a partially transparent color.

Choose **Render Viewshed Map** from the Render menu to bring up the dialog shown above. You can set the viewpoint by entering numeric coordinates in the **Viewpoint Coordinates** section, or graphically by control clicking in the preview square.

For more accurate results, especially if the map covers a large area, choose the **Sphere** earth model. Otherwise, select **Plane** because rendering is much faster.
In the **Map Type** section, you can choose to mark either the viewable or hidden area. Click in the color squares to set the viewshed and viewpoint marker colors. The viewshed color transparency and the viewpoint marker size are adjustable.

Click on the **Brightness / Contrast** button to bring up a dialog for adjusting the image. You can fine tune your adjustment with a real-time preview.

The background (all the unmarked area on the map) can be a shaded relief map, a solid color, or transparent, as specified in the ‘Background’ section.

You may wish to show only a portion of the map. You can do so by dragging a rectangle over the desired area on the map preview. If you zoom in too far, you can click the **Zoom Out** button to view the full extent of the map.

You can click **Preview** at any time to see how the map will look. Click **Render** when you are satisfied with the settings, which will dismiss the dialog and create a full size viewshed map.

**Contour Maps**

Natural Scene Designer Pro has a built-in contour generator. They may be used as overlays within the program, or exported as shapefiles.

Choose **Create Contour Map** from the Overlays menu to bring up the dialog shown above. You can set the contour base level, interval, and major contour interval. If you don’t want major contours, you can set it to **None** in the popup menu.
The line width, color, and transparency are also adjustable. However, those settings have no effect if you export the contour map as a shapefile, which can be done using the **Export** button in the Overlay Settings Panel.

When done adjusting the settings, click **OK** to create a contour map. When complete it will be displayed on the map as shown below.
Saving Vector Files Which Match Rendered Images

When you have imported shapefiles into your Natural Scene Designer Pro project, they are normally rendered together with the terrain and other objects in your scene as shown in the example above. While this may be suitable for display on computer monitors, it is not optimal for high resolution output or print. The resulting output lines would look pixelated and jagged.

Since shapefiles are two dimensional, they will not match the rendered output after they have been draped over terrain models unless the view direction is straight down looking from an infinite altitude (an orthographic view). For perspective views from an oblique angle, Natural Scene Designer Pro can transform the linework into an **SVG** (Scalable Vector Graphic) file which matches the rendered output. This is a popular vector file format which is based on an open standard and is widely supported by other software.

To create a matching **SVG** file, select **Create SVG Files for Shapes** at the bottom of the **Save Picture** dialog. Then after saving the image, the program will transform the shapefile to precisely match the rendered image. It will save the **SVG** file (with ‘.svg’ extension) in the same directory where you save the picture.
Important note: Since the SVG file is generated by the program during the save process (not while rendering the picture), it is critical that you do not change any program settings, especially the camera viewpoint and direction, between the time the image is rendered and when you save it. If you do, the SVG will not match the rendered image.

Grand Teton trails matching the image. Stored as vectors in an SVG file.

After saving the picture and corresponding SVG file, you can use them within your favorite illustration software which supports SVG file import. If you have imported multiple shapefiles into your project, a separate SVG file will be created for each one.

Note that it is usually best to hide the shapefile before rendering your final output. To do this, select your shapefiles in the Overlay Settings panel and click Properties. Then in the Shape Settings dialog, unselect the Use Shape checkbox.
Introduction
Texture Shading is a relatively new method of creating highly detailed images from terrain models. Leland Brown developed the core algorithm and program code for texture shading. He presented his research in a presentation given at NACIS 2010 (an annual mapping conference) and the 2014 Mountain Cartography Workshop in Banff, Canada. He also created a command line program for texture shading GridFloat terrain models. For a complete description of Texture Shading along with presentations and source code, please see Leland’s website at https://app.box.com/textureshading/

Outline of the steps to produce a texture shaded image
1) Open or import a terrain model in one of many available formats. It will be shown on the Map window.
2) Optionally clip a selected area of interest or reproject the terrain model.
3) Choose Render Texture Shade from the Render menu.
4) Adjust the shading parameters in the dialog.

5) Click the **Render** button.

You may wish to begin experimenting now, or continue reading for complete instructions.

**Texture Shading Tutorial**

This tutorial will take you, step by step, through the process of rendering a texture shaded image.

Choose **Import GridFloat DEM** from the File menu. Navigate to the **Tutorial** folder on the Program Disc and select the file named “GrandCanyon.flt”. Then click Open and you should see the terrain model displayed as shaded relief in the Map window as shown below. You can use the controls in the upper left corner of the Map window to zoom in or out. You can scroll the viewable area with the scrollbars or the **Hand** tool in the toolbar.
Next, choose **Render Texture Shade** from the Render menu. This will bring up a dialog as shown below.

This dialog gives you control over the settings and the output dimensions. Changes to the settings are displayed instantly in the preview square so you can see what your output will look like ahead of time.

Choose **Green - Brown - Gray** from the **Palette** dropdown menu. This adds color to the image based on elevation. Several other color palettes are available. For more information about the color controls in this dialog, please see the section of this manual where it covers the Shaded Relief dialog.

The **Elevation <------> Texture** slider controls the amount of texture shading, and ranges from 0 to 200. A value of 0 here creates images shaded solely by elevation, with texture shading absent. As you increase the slider you will see increased detail as texture shading does its work, bringing out detail that may be hidden in shaded relief images (as seen in the Map window).

The default value of the **Elevation <------> Texture** slider is 75. This generally works well for many terrain models. However, this terrain model has vast areas above the canyon that are relatively flat. Move the slider to about 119, which seems like a good amount of detail without being too much.

The **Vertical Enhancement** slider adjusts the vertical exaggeration of the terrain on a logarithmic scale. Visually it appears similar to adjusting the image contrast. You may wish to experiment with various settings. A value of 5.9 seems to work well in this situation. If you set this value too high, detail will be lost in the darkest and lightest areas. If it is too low, you may not be able to see the texture shading.
After adjusting the controls, the dialog should look like it is below.

Now click the **Render** button. The program will now display the **Texture Shading Progress** dialog, followed by the **Coloring Progress** dialog. (If you had chosen the **Grayscale** palette, the coloring stage would have been skipped).

After rendering is complete, you will see the texture shaded image as shown below. Compared to the shaded relief in the Map window you can see increased detail, especially in the flat areas above the canyon. However, the depth of the canyon does not seem as perceptible as it is in a shaded relief map. For this reason, you might decide to use an image processing program to blend texture shaded images with corresponding shaded relief images from Natural Scene Designer Pro.
Georeferencing

Introduction
An image or terrain model is said to be “georeferenced” if it has information that relates pixels or elevation samples to a specified coordinate system and map projection.

Natural Scene Designer Pro can georeference images and terrain models using multiple methods. After the terrain is georeferenced, you will be able to drape matching images over it. Georeferenced images can be saved as GeoTIFFs along with a “world file” (also known as a “TFW” file) for use with other software.

Information you will need
To georeference an image you should know which projection, datum, and parameters it uses. Paper maps usually have this information in the margin. Natural Scene Designer Pro currently supports 40 of the most popular projections and 230 datums. Just select the appropriate choice from the popup menus.

Once you have this information, you can select **Georeference Image** from the Overlays menu (for images) or **Georeference Terrain** from the Terrain menu. Then choose the projection and datum.

Georeferencing Methods
Depending on which projection your map uses, there are up to 5 georeferencing methods available in Natural Scene Designer Pro.
The options are:

**Click on known reference points ...** - The most versatile and powerful georeferencing methods are “Click on known reference points and enter lat/lon coordinates” and “Click on known reference points and enter X/Y coordinates”. With these 2 methods, you can locate points where you know the coordinates. You can choose to enter them as lat/lon or X, Y. It’s usually easiest to enter points as lat/lon.

**Enter lat/lon range** - This option is available if your map uses the Geographic, Miller, or Mercator projection. They are the only projections where the north/south and east/west lines are always parallel to the edges.

**Enter pixel size and upper left coordinate** - If you don’t have a world file, but you know the upper left coordinate and the pixel size, you can select this option.

**Use world file** - Select this option only if you already have the world file (which should end with “.tfw”) and you know the projection, datum, and projection parameters (the world file does not contain this additional information). The program will prompt you to locate the world file on your system.

### Entering Projection Parameters

The projection parameters dialog for the “Albers” projection is shown above as an example. Other projections have different dialogs and parameters. Some projections, such as “British Grid” have no parameters. Please see Appendix A for descriptions of the available projections and their parameters.
Entering Reference Points

If you choose to georeference the image or terrain using reference points, you will get a prompt near the top of the screen after you have entered the parameters (if any). You’ll be asked to click the mouse pointer on the map (or image) and then enter the coordinates of that point.

You need to enter 2 or more reference points, depending on the quality of the data you are georeferencing. If it is not rotated, skewed, or distorted, then two points will be sufficient. It works best if you select points which lie on opposite corners.

If your data is rotated, but not distorted or warped, you should enter 3 to 5 points. It is best if they are located near the corners. You should not enter more than 5 points because the program will use a more complex point matching method which will be slightly less accurate.

If your data is distorted, skewed or warped, you should enter 6 or more (up to 100) control points, with several placed along the edges.
While you are entering reference points, you can use the magnifying, hand, and arrow tools, along with the scroll bars. These will aid you in precisely locating reference points. Note: If you use the magnifying or hand tool, be sure to switch back to the arrow tool when you are ready to click on a reference point.

Your chosen reference points will be marked, but not in your final output. Then the program will display a dialog for you to enter the coordinate of that point. When you are done entering points, simply click the “Done” button at the top of the screen.

If you have defined only 2 control points, which is recommended if your image is not rotated, then the program will not have to process and resample the image. Otherwise, it will be resampled.

When done georeferencing, you can check the results by running the mouse pointer over the georeferenced image or terrain model. The program will display the lat/lon coordinates for your verification.

Georeferencing Tutorial

This tutorial will guide you through the steps necessary to georeference a satellite photograph of California and Nevada, which was provided by Nasa’s “Visible Earth” project. Then you can drape this image over a terrain model and render an oblique view.

First, choose Georeference Image from the Overlays menu. When prompted for the file name, navigate to the “Tutorials” folder on the Program CD-ROM. Then select the “GeoRef Tutorial” folder and open the file named “ev22986.tif”.

The program will open the satellite photo and bring up the Image Projection Parameters dialog. We don’t know the projection used for this image, but since the state border lines are parallel to the image edges, it will be OK in this case to select the Geographic projection and the WGS84 datum in the popup menus.

After selecting the projection and datum, choose the radio button labeled Click on known reference points and enter lat/lon coordinates. Then click OK.

There are no parameters to enter for the Geographic projection, so the program will immediately prompt you to enter reference points.

Three tools are available while you are entering reference points. The Arrow tool is for clicking on reference points. You can use the Hand tool to scroll the image (the window scroll bars are also available). The Magnifying Glass tool can be used to zoom in or out. Note that the menus will not be available until you have entered all the reference points and clicked the Done button.
Now click the mouse pointer on the California/Oregon border where it meets the Pacific Ocean, as shown above. It’s near the upper left corner of the image. Then a dialog will appear and you should enter 42° for the latitude and -124° 13’ for the longitude. Then click OK.

Note: Negative longitudes are used to specify the western hemisphere. Negative latitudes indicate the southern hemisphere. If you accidentally forget to enter the “-” when necessary, you’ll get unexpected results.

Now you will enter the second reference point. Click the mouse pointer on the California/Arizona/Mexico border as shown above. It’s near the lower right corner of the image. Then a dialog will appear and you should enter 32° 43’ for the latitude and -114° 43’ for the longitude. Then click OK.

Since this satellite photographic is not rotated out of north/south alignment and does not appear to be distorted, the two reference points you entered are enough to georeference the image. The program will be able to calculate the coordinates of the upper left corner and the pixel scale in each di-
mension. So click the **Done** button. The image should now be georeferenced. You might want to run
the mouse pointer over the image and view the lat/lon values displayed at the top of the window to see that they are correct.

Now you will load a terrain model of this area. Choose **Open** from the File menu. When prompted
for the file name, navigate to the “Tutorials” folder. Then select the “GeoRef Tutorial” folder and
open the file named “Central Valley.nsd”.

Choose **Use Displayed Image as Overlay** from the Overlays menu. Now close the window with the
satellite photo. Then go to the Map window and you should see the satellite photo draped over the
terrain.

Finally, select **Render Picture** from the Render menu. If you have not changed the camera settings,
you should see a picture like the one shown below -- looking north up California’s central valley. To
add definition to the terrain, the vertical exaggeration was set to 2X.

To show the Earth’s curvature, the **Earth Model** for this tutorial was set to **Sphere**. You can change
the **Earth Model** in the World Settings panel. Since the camera is positioned above the atmosphere,
the sky color ranges from blue to black.

To explore further, you might want to render a shaded relief map of this terrain with its matching
overlay. If so, choose **Render Shaded Relief** from the Render menu. Then set the image size to about
2000 x 2000 and click the **Render** button. After the map has been rendered, choose **Save As** from the
File menu . Save it as a TIFF file, which will automatically include GeoTIFF tags containing
goreferencing information. Or if you choose another file format besides TIFF, be sure to select the
option in the save file dialog to **Create TFW file**. When done, you will be able to load the map and
quickly georeference it using the TFW file. This shaded relief map and TFW file will be the starting
point for the reprojection tutorial in the next chapter. However, if you skip this optional step, you can
still complete the reprojection tutorial using files from the CD-ROM.

There are thousands of satellite images available for downloading on the internet. The “ev22986.tif”
image used in this tutorial was provided by NASA’s Visible Earth web site, which is at http://
visibleearth.nasa.gov

---

The final rendered view of the satellite photo draped over the terrain
Globe Rendering Tutorial

This tutorial will teach you how to create an image of the entire earth from space, using Natural Scene Designer Pro’s spherical terrain mode. The source files used in this tutorial are derived from data kindly provided by Tom Patterson. They have been modified and downsampled for use in this tutorial. Tom’s website is at http://www.shadedrelief.com. There you will find the original full resolution maps used in this tutorial along with other maps, articles, tutorials, and resources for making maps.

First, choose Import Grayscale DEM from the File menu. Then navigate to the Tutorials directory on the Program CD-ROM and then the Globe Tutorial directory. Select the file named “GrayscaleGlobeDEM.tif” and open it. When prompted for the elevation range enter 8248 for the maximum elevation and -10701 for the minimum and click OK.

You will see terrain in the Map window with extremely steep features. This is because it has not been georeferenced.

Select Georeference Terrain from the Terrain menu. The default parameters in the dialog are fine. Make sure that the georeferencing method is set to Enter lat/lon range and click OK.

Then you will see the Enter the Latitude and Longitude range dialog. The default values are for the entire earth, so just accept them and click OK. Now the terrain model is georeferenced and has the correct sample distance.

Choose Import Image and Scale to Fit from the Overlays menu, then navigate to the Globe Tutorial directory and select the file named “GlobeOverlay.jpg”. This overlay is already matched to fit the terrain. Click OK to import and drape the overlay over the terrain.

To make the features of the earth more noticeable, choose Vertical Exaggeration Factor from the Terrain menu. Enter a value of 3 and click OK.

Now we need to make the earth round. Select the World Settings panel and set the earth model to Sphere.

To shade the sky appropriately for this project, select the Sky Settings panel. In the Sky Color Pre-sets popup menu, select Globe. Also, be sure to set Haze to 0%. Otherwise, it may obscure parts of the globe.

To quickly position the camera, select the Camera Settings panel to show the numeric camera settings. Enter the following values: Dir 0, Pitch -90, Bank 0, East 8236800, North 11865600, Altitude 15000000 and Lens 35,

To set a good light direction, select the Light Settings panel. Enter 270 in the Direction field and 35 in the Angle field and press Return to enter the changes.

We should be ready to render a picture now. The Camera window should appear as shown on the following page.
Finally choose **Render Picture** from the Render menu. Set the image size to 1200 x 1200. Make sure that the **Ray Trace** rendering method is selected and click **Render**. The resulting image is shown below. You might wish to experiment with different settings, camera positions, and lighting angles.
Reprojecting Images and Terrain

Natural Scene Designer Pro offers 40 projection choices in its popup menu. You can reproject terrain models and images. Some projections are suitable for small areas, such as cities, counties, or small states. Other projections are best for continental size datasets, and several are intended for world maps only.

This program has been designed for optimum memory efficiency when reprojecting very large images. You should be able to reproject very large images.

Reprojection Usage
There are many uses for the reprojection capability in Natural Scene Designer Pro. Here are only a few:

1) To prepare for draping a map over a terrain model -- their projections must match.

2) Many terrain models are available in Geographic projection. These are usually known as “One Degree”, “90 meter”, “SRTM” or “GTOPO 30” models. However, their aspect ratio is wrong in proportion to their distance from the equator. To correct this you can reproject the terrain model to UTM, for example, where the aspect ratio will be much closer to reality.

3) You can georeference satellite photos or aerial imagery and then reproject them to match your terrain model.

Available projections
Albers
Azimuthal Equidistant
Bonne
British Grid
California Teale Albers
Chamberlin Trametric
Eckert IV
Equidistant Conic - 1 parallel
Equidistant Conic - 2 parallels
Geographic
Gnomonic
Goode Homolosine
Hammer-Aitoff
Lambert Azimuthal
Lambert Conformal Conic
Mercator
Mercator (Web)
Miller Cylindrical
Mollweide
Natural Earth
Natural Earth II
Oblique Mercator
Orthographic
Patterson
Perspective
Polyconic
Robinson
Sinusoidal
State Plane 1927
State Plane 1983
Stereographic
Tilted Perspective
Transverse Mercator
Two Point Equidistant
US Albers
UTM
Van der Grinten
Winkel I
Winkel II
Winkel Tripel

Please see Appendix A for descriptions of the supported projections and their parameters.

Before continuing, you should be familiar with the material in the “Georeferencing” chapter. All images and terrain models must be georeferenced before you can reproject them. However, most terrain models are already georeferenced when opened. Most images, except for GeoTIFFs, are not automatically georeferenced when opened. If you select the reprojection function on an image or terrain model that is not already georeferenced, then you will be guided through that step first.
Reprojecting an Image

Choose **Reproject Image** from the Overlays menu to bring up the dialog shown above. Then select the desired new projection and datum. The ellipsoid corresponding to the selected datum will be displayed. Note that the datum and ellipsoid choice does not affect projections which use the spherical earth model. Please see Appendix B for more information about map datums.

After you click **OK** in the Reprojection dialog, the program will display a **Projection Parameters** dialog (if applicable). Then after entering the parameters and clicking **OK**, the **Output Image Settings** dialog will be displayed.

You can set the size of the output image, adjust the extent, view a preview, or go back and change the projection parameters if necessary.

When you click **OK** the program will reproject the image according to your specifications.
Reprojecting a Terrain Model

Choose **Reproject Terrain** from the Terrain menu to bring up the **Reprojection** dialog. This function is similar to the Reproject Image function as previously described. However, it does not display the **Output Image Settings** dialog. Instead, you just enter the desired terrain sample distance when prompted.

**Tutorial: Reprojecting a Map**

This tutorial will guide you through the steps necessary to reproject a shaded relief map from Geographic to the California State Plane 1983 system. Our starting point will be a shaded relief map and corresponding TFW file created by Natural Scene Designer Pro. The image was generated using the completed terrain model and satellite overlay from the Georeferencing tutorial in the previous chapter.

First, choose **Reproject Image** from the Overlays menu. When prompted for the file name, navigate to the “Tutorials” folder on the Program CD-ROM. Then go into the “Reprojection Tutorial” folder and select the file named “CalNevada.jpg”.

The program will open the shaded relief map and bring up the **Projection Parameters** dialog. Select the Geographic projection and the WGS84 datum in the popup menus. Then select the **Use world file** option for georeferencing and click **OK**.
The program will ask you to locate the world (TFW) file. Navigate to the “Tutorials” folder on the program CD-ROM. Then go into the “Reprojection Tutorial” folder and select the file named “CalNevada.tfw”.

The shaded relief map is now loaded and georeferenced. The program will prompt you for the new projection and datum.


You’ll get another dialog asking you which State Plane to use. Select **California III 1983** and click OK.

Finally, you will see the **Output Image Settings** dialog. You can change the image output size, set the background color, sampling method, extent, and parameters. Click **Preview** to see what the reprojected map will look like. Then click **OK**.
The final reprojected map is shown above. Note that California no longer appears stretched horizontally, as it did in the Geographic source image.
Tutorial: Reprojecting Terrain

In this tutorial, you will reproject a Terrain model and then drape two DRGs (scanned topographic maps) over it.

First, choose Open from the File menu. When prompted for the file name, navigate to the “Tutorials” folder on the program CD-ROM. Then select the “Topo Tutorial” folder and open the file named “ElCap.nsd”.

This terrain model contains Yosemite Valley and El Capitan. It uses the UTM projection and the North American 1983 datum. To verify this, choose Terrain Info from the Terrain menu.

The two DRGs that will be draped over this terrain use the California Teale Albers projection and the North American 1927 datum. So you will need to reproject the terrain to match the projection and datum of the DRGs.
Choose **Reproject Terrain** from the Terrain menu. The program will display a dialog asking you for the new projection and datum. Select the **California Teale Albers** projection and the **North American 1927, CONUS** datum in the popup menus. Then click **OK**. Now you will be prompted to enter the sample distance. The preset value of 30 is fine, so click **OK** and the program will reproject the terrain. It also “reprojects” the current camera location, and any existing animation path or overlays.

Now verify that the terrain is in the correct projection and datum. Choose **Terrain Info** from the Terrain menu. The Terrain Info dialog shows the new projection and datum, along with other information.

---

**Terrain Info**

- **Name:** BUCKINGHAM MOUNTAIN, CA
- **Projection:** California Teale Albers
- **Datum:** NORTH AMERICAN 1927, CONUS
- **Ellipsoid:** Clarke 1866
- **Size:** 1473 rows x 1553 columns
- **Elevation Storage:** 32 bits
- **Sample Spacing:** 30. meters
- **Elevation Range:** 438 to 3562 meters
- **Latitude Range:** 37.4852665 to 37.8860699
- **Longitude Range:** -113.889628 to -119.35616
- **1st Std. Parallel:** 34.
- **2nd Std. Parallel:** 40.5
- **Central Meridian:** -120.
- **Origin Latitude:** 0.
- **False Easting:** 0.
- **False Northing:** -4000000.
Now you’re ready to drape the two DRG’s over the terrain. Since there are two adjacent DRGs, they will need to be decollared so they can be seamlessly merged. The **Import DRG or DOQ** function will do this automatically.

Choose **Import DRG or DOQ** from the Overlays menu. When prompted for the file name, navigate to the “Tutorials” folder on the program CD-ROM. Then select the “Topo Tutorial” folder and open the file named “o37119f5.tif”. The program will display a dialog which gives you options for decollaring the image.

![Import DRG/DOQ dialog box](image)

Select the option labeled **Remove line at edges**. This is recommended for adjacent DRGs. The numeric border values don’t require changing here. Click **OK** and the program will decollar the image and drape it over the terrain in the correct location.

Now drape the second DRG by choosing **Import DRG or DOQ** from the Overlays menu. Open the file named “o37119f6.tif”. You’ll see the **Enter Image Border** dialog again. Select the **Remove line at edges** options and click **OK**. After the program decollars the image you will see the two DRGs merged together (without their white borders) in the Map window.
Finally, choose **Render Picture** from the Render menu. When done rendering, you’ll see a view looking eastward from the Yosemite Valley floor. Renderings like this with topographic overlays could be helpful when planning trips.
Tools and Windows

Toolbar Buttons
The Toolbar contains two groups of buttons. The buttons in the left group are for frequently used commands. The buttons in the right group are tools. Natural Scene Designer Pro displays a brief summary of each button when the mouse pointer travels over it.

Open Terrain CD/DVD-ROM – To use this function, you must have the program CD-ROM or a 3D Terrain model CD/DVD (sold separately) in your drive. Clicking this button will bring up the Open Terrain CD/DVD-ROM dialog, which lets you open terrain models using a large scale map.

Undo Button — Click this button to undo the most recent camera view change, terrain edit, lake, key frame movement, insertion or deletion.

Drop To Ground Button — Places the camera 10 meters above the ground. If a 3D object is selected, it will be placed at ground level and the camera location will not change.

Insert Key Button — Inserts a key frame at the current camera location.

Delete Key Button — Deletes the currently selected key frame (if any).

Previous Key Button — Selects the previous key frame and positions the current view there. Then it updates the Camera window.
**Next Key Button** — Selects the next key frame and positions the current view there. Then it updates the Camera window.

**Arrow Tool** — This tool is used for selecting and dragging key frames, overlays and 3D objects. It also resizes a 3D object when you drag its scale handle. You can only resize a 3D object in the Camera window, not in the Map.

**Hand Tool** — Some terrain models are larger than the displayed area of the Map window. If you want to view an area that is not displayed, select the **Hand** tool. Then press and hold the mouse button while dragging the terrain to bring the desired area into view. You may also accomplish this by using the scroll bars, but they can move in only one direction at a time.

In the Camera window, the **Hand** tool can be used for panning the view. After selecting this tool, press and hold the mouse button while dragging the view. The view will move as you move the Hand pointer.

Tip: Press the Space bar to temporarily switch to the Hand tool. When you are done, release the Space bar and the program will switch back to the previous tool.

**Paint Brush** - Paints the terrain with the current elevation, as shown in the Tool Options panel. Areas painted will be changed to this elevation.

You can also use this tool for painting the background tree map. To go into this mode, click the little tree button in the lower left corner of the Map window.

**Eye Dropper** - Use this tool to set the current elevation for painting. You can click on the terrain where it has the elevation you want. Or you can enter the elevation numerically in the Tool Options panel.

**Eraser** - This tool is functional only in background tree editing mode. Use it to clear painted areas in the tree map.
**Magnifier** - Enlarges or reduces the image in the Map, Camera, or Picture display window. (To reduce the image, press and hold the Option key first). If you drag select an area, the program will zoom in on it.

Tip: Press Control + Space to temporarily switch to the Magnifier tool. Or, press Shift + Space to reduce the image.

**Paint Bucket** - This tool is similar to the Lake tool. But instead of filling with water, it fills low areas with terrain. The area lower in elevation than where you click on the Map is filled with flat ground.

**Lake Tool** — Select this tool to create a lake. Then click the mouse with the pointer positioned at what you want to be the shore of the lake. You should see a lake fill the landscape at and below the point you click. If you have enough available memory you will be able to undo the lake if you are not happy with it. You may create up to 64 lakes per project.

**Raise Tool** - This raises the terrain at the location where you click on the map. The Tool Options panel lets you set the size of the area and distance to raise it. The raised area will be blended into the surroundings.

**Lower Tool** - This lowers the terrain at the location where you click on the map. The Tool Options panel lets you set the size of the area and distance to lower it. The lowered area will be blended into the surroundings.

**Clipping Tool** — Lets you clip an area of terrain in the Map window. After you drag select an area, the area outside it will be removed.

If you press and hold the Shift key before drag selecting, it will constrain your selection to a square area.

After you select the area to be clipped, the program displays a dialog to confirm your selection.

**Rotate Tool** — Use this tool to select a 3D object in the Camera window and rotate it using its handles.
On the map, you can rotate an object around its vertical axis by dragging the mouse pointer around the object. Rotate handles do not appear on the map.

**View Changing Tool** — This tool lets you change the field of view and the viewing direction. For telephoto lens selection, move the mouse pointer away from the camera (located where the view field lines meet) while holding the left mouse button down. To select a wider angle of view, move the mouse pointer closer to the camera. To change the view direction, move the mouse pointer around the camera. When you let go of the mouse button, the program will update the Camera window and the Camera Settings panel fields.

To change the view direction without changing the field of view, press and hold the **Shift** key and then press and hold the mouse button.

**Location Tool** — When this tool is selected, the camera will move to wherever you click on the map. The Camera window will show the view from the new location. The **East** and **North** camera coordinates in the Camera Settings panel will be updated to reflect the new location of the camera. If you want to go back to the previous location, click the **Undo** button in the Toolbar.

**Straight Path Tool** — When this tool is selected, clicking the mouse will insert a key frame at the location of the mouse pointer. If other key frames already exist, it will create a straight path between the previous key frame and the newly created key frame.

**Curved Path Tool** — This tool is similar to the straight path tool, except it creates curved instead of straight paths. To create a curved path, select this tool and then click the pointer over each location on the map where you want a key frame.
Camera Window

The Camera window always shows a simplified image of the current camera view. You may use it to interactively position the camera, change the view direction, and adjust the bank and pitch angles.

Whenever you load an existing terrain, or create a new one, the Camera window displays it from the current viewpoint. Changing the camera location, direction, lens, lighting, ocean level, and various other settings will automatically update the Camera window. The Camera window can show a preview, which a rough approximation of the actual landscape. The preview will not show clouds, waves, or background trees in order to save time. To see those, click the Ray Trace button. Note that it is a one-time use button. After the ray traced image is displayed, the display will, by default, go back to preview mode the next time you move the camera or do anything to trigger an update. Depending on the complexity of the scene, ray tracing may take a significant amount of time.

You can easily move the camera using the six direction buttons below the preview image. There are buttons for moving up, down, left, right, forward, and backward. Clicking these buttons moves the camera in the specified direction. The camera will move by the amount (in meters) specified in the Distance field. (You must press Return after entering a new value in the Distance field). For example, if the distance is 100, then clicking the Fwd button will move the camera forward 100 meters. Note that movement is always relative to the camera, not the landscape. For example, if the camera is pointing straight up, then clicking the Fwd button will increase the camera altitude. If the camera is aimed level to the horizon, then clicking the Fwd button will move the camera toward the horizon. You may click the Undo button in the Toolbar, or choose Undo from the Edit menu to return to your previous camera location and viewing direction.
Click the small up and down arrows to the right of the **Move Distance** field to quickly double or halve the move distance. You can, of course, click it multiple times until the desired move distance is shown.

The Camera window can be used to change the composition of your picture. You may frame your view by using the mouse to drag a rectangle over the desired area.

**Magnifier tool**

To zoom in on an area, first select the Camera window (if it is not already selected). Then select the **Magnifier** tool. Move the mouse pointer to what you want to be the upper left corner of the picture. Press and hold down the mouse button while you move it to the lower right corner of the picture, then release it. The view will quickly zoom in to the framed area.

To change the view direction without zooming in, click the mouse button anywhere in the preview window. The location you click will become the new center of view.

![Magnifier tool diagram]

The **Bank control** is a square with black representing the earth and white representing the sky. There are little marks every 45 degrees for reference. To alter the bank angle, press and hold the mouse button while dragging and rotating the black area to the desired setting. The numeric bank angle is shown in the Camera Settings panel.

![Bank control diagram]

The **Pitch control**, located immediately to the right of the bank control. The black line represents the pitch. There are marks every 45 degrees. A pitch of 0 degrees (camera pointing at the horizon) is represented by the black line going from the center of the square to the right. A pitch of 90 degrees (straight up) is represented by the black line going from the center to the top of the square. A pitch of 180 degrees or -180 degrees (looking at the horizon upside down) is represented by the line going from the center to the left of the square. To adjust the pitch, just drag the pitch indicator to the desired setting. The numeric pitch angle is shown in the Camera Settings panel.
The Map window shows a shaded relief view of the terrain. Dark green indicates the lowest elevations. Brown indicates higher elevations, and gray indicates the highest spots. The two lines which form a “V” show the camera field of view. Another set of lines (or curves) shows the camera path if it has been defined. A dot on the path indicates the location of a key frame (described in the “Animation” chapter).

When you move the mouse pointer over the map, you will notice that the east, north, and elevation values are constantly displayed at the top of the window. These coordinates describe the location of the pointer, not the camera. The elevation of the land at the location under the pointer is also shown.

There are three viewing modes available. They are selected using icons in the upper left corner of the Map window. The shaded relief view mode has already been described. There is also Profile mode which shows a side view of the landscape underneath the camera path. The small tree button is for background tree editing mode. You may switch between the three modes at any time, however, Profile mode is most useful when there is a camera path defined.
The Map Window in Profile Mode

The Profile mode shows the camera and ground elevation, the pitch, and the vertical field of view. Altitude is represented on the vertical axis (it is displayed constantly at the top of the screen). Distance along the camera path (if any) is represented on the horizontal axis. Profile mode is useful for adjusting an animation path. Although it can still be used when rendering a picture from a stationary viewpoint, you will see only a dot and some lines representing the camera field of view. The ground will be completely flat since only the elevation below the camera is shown. The main purpose of profile mode is for adjusting animation paths.

You may modify the altitude and pitch in this mode. To change the altitude, use the Location tool and click with the pointer at the desired altitude. To move a key frame, use the Arrow tool to drag it to the desired altitude. You can only change the altitude of a key frame, not its east or north coordinates in Profile mode.

To change the pitch and field of view, use the View Changing tool the same as you would in shaded relief mode.

The Lake, Straight Path, Curved Path, Terrain Editing, and 3D Object tools are not available in Profile mode. To return to map mode, just click on its button.
Terrain Editor

Five tools are available for editing terrain. These tools include a paint brush, eye dropper, paint bucket, raise terrain tool, and a lower terrain tool. To use these tools, you first click on the tool to select it. Then you click or drag the pointer in the Map window. Note that these tools do not work in Map Profile or Background Tree Map mode.

Select Map mode for editing terrain

To undo a change to the terrain, choose Undo from the Edit menu. You can undo only the previous change, so be sure you are satisfied with each change before clicking the mouse again.

Some of these terrain editing tools will bring up a Tool Options panel, which will be displayed on the right side of the toolbar. All values should be entered in meters. The exception is Brush Hardness which is entered as a percentage (0 to 100). Note that Brush Hardness is available only when the round brush shape is selected.

Eye Dropper - Use this tool to set the current elevation for painting. You can click on the terrain where it has the elevation you want. Or you can enter the elevation numerically in the Tool Options panel.

Paint Bucket - This tool is similar to the Lake tool. But instead of filling with water, it fills low areas with terrain. The area lower in elevation than where you click on the map is filled with flat ground.

Paint Brush - Paints the terrain with the current elevation, as shown in the Tool Options panel. Areas painted will be changed to this elevation. You can use this tool for many tasks, including leveling off an area or building a “dam” at a lake outlet. The Tool Options panel allows you to set the brush size and shape (round or square).

When the brush shape is set to Round, you have control over the brush hardness. If you want the change in elevation blended with the surrounding terrain, enter a hardness value of 0. For abrupt changes, use a hardness value of 100.

Raise Tool - This raises the terrain at the location where you click on the map. The Tool Options window lets you set the size of the area and distance to raise it. The raised area will be blended.

Lower Tool - This lowers the terrain at the location where you click. The Tool Options window lets you set the size of the area and distance to lower it. The lowered area will be blended.
The Camera Settings Panel

The Camera Settings panel has numeric fields describing the current camera location and view direction.

There are eight numeric fields in the Camera Settings panel. Note that you must press Return after entering a new value in any of these fields. Otherwise, the new value will not take effect. As confirmation, when you significantly change a value in these fields, you should see it reflected immediately in the Camera and Map windows.

**East, North, Alt** — These three numbers are the coordinates of the current camera location (in meters).

**Dir** — This field is the camera view direction in degrees. The camera view direction is also indicated in the Map window.

**Pitch** — This is the horizon angle in degrees. Zero is perfectly level. The pitch is also indicated in the Camera window.
**Bank** — This is the camera bank angle in degrees. For example, 0 is level and +45 is like being in an airplane making a right turn (right wing drops). The bank is also indicated in the Camera window.

**Lens** — This field is the focal length of the camera, in millimeters. Use values that are appropriate for a 35 mm camera. For example, wide angle is 18 and telephoto is 400mm.

**Speed** — This is the camera speed in meters per second. You can change it at any time, but it is used only during animations.

If you want a constant camera speed throughout the animation, set the speed value before you begin to create keyframes. The speed value is stored in each keyframe.

For a variable speed animation, enter the desired speed in each keyframe. Select the keyframe on the map and enter the speed. Be sure to press **Enter** so that the change takes effect. Continue this process for each keyframe you want to change.
Preferences Settings

Natural Scene Designer’s Preference dialog lets you set many program options. It also gives you a choice to automatically load any project file at startup. You can access it from the Edit menu.

Initial Camera Placement - Enter the elevation (relative to the terrain) to place the camera when importing a DEM or creating a new fractal landscape. You can also enter the starting pitch angle.

Change Startup Settings - The selected Natural Scene Designer Project file will automatically be loaded every time the program starts. If you click Startup With Default Settings, the program will not load a project file at startup.

Camera Move Distance - This controls the distance (in meters) that the camera moves when you click one of the Move buttons in the camera window.

Auto Bank Speed Limit - When the Auto Bank option is on in the Path menu, Natural Scene Designer Pro uses the camera speed and turn radius when computing the camera bank angle along a flight path. If the camera is going too fast, you will always end up with 90 degree banking in turns, unless you set an appropriate speed limit. Note that the speed limit you enter is only for computing the amount of banking, not the actual camera speed or the distance it travels between.

Auto Bank Amount - You can use this to control the amount of camera banking in turns. 100% is normal. You can change this value if you want a different amount of banking.

Reset Warning Messages - Some of the warning messages displayed by this program contain check boxes where you can turn them off. Clicking Reset Warning Messages will turn them all back on.

Terrain Elevation Storage - This lets you select the elevation precision. You have a choice of Automatic, 16 bit, and 32 bit.
The **Automatic** setting uses 32 bits per elevation if enough RAM is available. If not, it uses 16 bits per elevation.

The **16 bit** setting rounds all elevations to the nearest meter. This allows for more efficient storage, but can result in a loss of vertical precision and may cause stair-stepping artifacts, especially on low sloping surfaces or when the sampling distance is 10 meters or less.

The **32 bit** setting uses a 32 bit floating point number storage format. This allows for much better vertical elevation precision, but doubles the amount of memory needed.

**Camera Window Aspect Ratio** - The Camera Window aspect ratio may be changed (within limits) to match the aspect ratio of fully rendered output. You can either set it at **Fixed** and enter a value, or have it use the same aspect as the Render Settings.

Note that the aspect ratio is the width (in pixels) divided by the height.

**Automatically check for updates** - If you choose to check for updates automatically you will be informed at program startup when a newer version is available.

Or you may check for updates manually at any time using the “Check for newer version” function in the **About** menu.

**Use Terrain Blend Colors in Map Window** - By default, the program uses a fixed set of colors for display in the Map window. With this option on it uses the blend colors you have set within the Terrain Settings dialog.

**Disable Multithreading** - Setting this check will turn off multithreading. Normally you should leave this unchecked (not disabled) for maximum rendering speed.

However, you might want to disable multithreading if you are rendering, for example, a time-consuming animation and you want Natural Scene Designer to limit itself to only 1 processor, so you can do other work on the computer while rendering.

**Display Decimal Latitude / Longitude** - By default, the program displays latitudes and longitudes in degree/minute/second format. This option changes it to display decimal degrees.
3D Objects

Natural Scene Designer Pro lets you easily create, import and place 3D objects in your scenes. There are three categories of objects supported: primitives, imported QuickDraw 3D (3DMF) or 3D Studio (3DS) objects, and internally generated objects (trees, bushes, and rocks). Each category of object will be discussed in this section, along with examples for common operations.

The Objects window displays small size previews. It’s used as an object holding area, which makes it easy to manage objects. Using this window you can place multiple copies of the same object in a scene without having to reload it each time.

Once an object is placed in the scene, you can rotate, move and resize it. When an object is selected, it appears in the Camera window with a box when the Arrow tool is active. You may use the Arrow tool to resize an object by dragging its scaling handles. If you press the Shift key before you move the scale handle, the scaling will be uniform in all 3 dimensions.
When the **Rotate** tool is active, the program draws the object with 3 circles and rotation handles where the circles meet. To rotate an object, drag the rotation handle in the desired direction. The object will follow the rotation of the handle. You may use either the **Arrow** or **Rotation** tools to move an object left, right, up, or down. To move it toward or away from the camera, just press the **Control** key before you begin to drag the object. Then you will be able to move the object forward, backward, left, or right.

Objects are shown in the Camera window with solid 3D shading. Objects appear on the Map window from an overhead view without shading. You may manipulate objects in either the Map or Camera View windows, or you may find it convenient to switch back and forth.

**Primitive Objects**

Natural Scene Designer Pro supports 4 primitive object types: cones, cylinders, boxes, and ellipsoids (including spheres). To create, position and manipulate a primitive object:

1. First make sure you have either opened an existing project, or created a new fractal landscape.

2. Choose the desired primitive object from the Objects menu. The program will create the object and place it in the Objects window. Click in the Objects window to select the object.

3. Click in either the Map or Camera windows at the location where you want to place the primitive object.

4. Once placed in a view, you can use the **Arrow** tool to select, drag or resize the object in the Camera View window.

5. To rotate the object, select the **Rotate** tool and drag the rotation handles around in the Camera window. To rotate the object around its vertical axis in the Map window, select the object and drag around the center of the object. A box with alignment axes is drawn during rotation on the Map.

6. To change the surface or to get numeric information about an object, choose **Properties** from the Objects menu.

7. To place multiple copies of the same primitive, double-click on its image in the Objects window. This “locks” the tool to stay set. Now, each click in either the Map or Camera window will create a new object. To get out of “locked” mode, just click on another tool in the Toolbar.
Importing Objects

Natural Scene Designer Pro imports objects in Apple’s QuickDraw 3D (3DMF) and 3D Studio (3DS) formats. If the object contains a texture, it will be seen in ray-traced renderings, but not in the Object window.

The 3D Object Options dialog gives you the chance to make some preliminary adjustments to an object as you begin to import it.

If you know what units (inches, feet, meters, etc.) were used when the object was created in its modeling program, you can select the appropriate unit of measurement. Then the object will appear in the correct scale when placed in a scene. For example, if you are importing a model of a building and its measurements are in feet, the correct setting would read “One 3D Object unit is 1 foot”. If you want to make the building 2 times larger, you could enter a 2 in the numeric field. If you don’t know what the model unit of measurement is, you can adjust its size after importing it by using the Object Properties dialog, or by dragging its scale handles in the Camera View window.

The Edge Smoothing buttons control whether the object edges will be smoothed during rendering or appear faceted. You may use the settings in the object file or you may override them. Edge smoothing can also be adjusted in the Object Properties dialog. You can see the effect of smoothing in ray traced renderings, but not in the Preview or Quick Test rendering modes.

The Backface buttons control whether or not back-facing polygons will be rendered. The polygons in some imported objects may be facing the wrong direction. If so, the object will appear to have missing pieces when rendered. You can correct this situation by choosing Always Include, however you should not do this unless you’re sure that you need to. Checking Always Include will increase the rendering time and may result in a slight reduction in the rendering quality.

To import an object:

1. First make sure you have either opened an existing project, or created a new fractal landscape.
2. Select Import 3DMF from the Objects menu.
3. After entering the file name and clicking Open, you will see the 3D Object Options dialog. You can scale the object while loading, choose whether or not you want back-facing polygons, and decide whether or not you want edge smoothing. Usually, it works fine if you go with the default settings.
4. After the object loads, a small image of it will appear in the Objects window. This window is a holding area where objects may be selected and placed on the Map or in the Camera window.

5. To place the object, first make sure it is selected in the Objects window. It should have a red frame around its border. Natural Scene Designer Pro treats imported objects in the Object window as tools. So when its small image is selected, the active tool is considered to be the imported object.

6. Click the mouse pointer in the Camera or Map window where you want to place the object. (The window must be active before it will accept objects).

7. To place multiple copies of the same object, double click on its small image in the Object window. Then every click in the Map or Camera window will place a new copy of it. When done placing multiple copies, just select another tool.

Creating and Placing Trees

Natural Scene Designer Pro can create four types of realistic trees - Oak, Palm, Redwood, and Sweet Gum.

To create and place a tree:
1. First make sure you have either opened an existing project, or created a new landscape.
2. Choose Create Tree from the Objects menu.
3. Select the type you want and adjust the settings as needed in the Tree dialog. Press the Preview button to see what the tree will look like.
4. Click OK and the program creates a small tree image in the Objects window.
5. Select the tree in the Objects window. The tree becomes the selected tool.
6. Click in the Map or Camera Window to place the tree. Note that the point you click is where the base of the tree will be. If you click a point in the sky, nothing will happen.
7. Now you can drag the tree to move it as previously described for other types of objects.
8. To place multiple copies of the same tree, double click on its small image in the Objects window. Then every click in the Map or Camera window will place a tree. When done placing multiple trees, just select another tool.

Bushes and rocks are created and placed using a similar procedure.

Note: Trees and bushes may be moved, but not rotated or scaled.
Placing Objects in the Map Window

The Map Window is useful for placing multiple copies of the same object. You may zoom in to a particular area of a landscape and place objects like you are using a rubber stamp. When placing objects in the Map window, they are automatically positioned at ground level.

You may find it convenient to place objects on the map at first, and then “fine tune” their position by returning to the Camera View window. Both windows are always updated when an object changes.

To rotate an object on the Map, select the Rotation tool. Then select the object and drag the mouse around its center. On the Map, rotation is limited to the object’s vertical axis only.
For numeric information about an object, select it and choose **Properties** from the Object menu. This displays the Object Properties dialog. You can set the object’s surface properties, numeric position, size, direction, and speed. Trees have a special properties dialog that lets you change their parameters.

The **Location** fields let you adjust an object’s precise location. For objects that move during an animation, the Location entered is the object’s starting point. The number in the **East** field is the object’s distance from the western edge of the landscape (left hand side of the map). The number in the **North** field is the object’s distance from the southern edge of the landscape (bottom edge of the map). The **Altitude** field contains the distance above sea level, not the distance from the ground surface.

The **Motion** fields let you define an object’s direction and speed along a straight path during an animation. The **Direction** field is the compass direction of travel, specified in degrees. The **Pitch** is the upward or downward angle in degrees. Positive pitch values specify upward motion. Zero pitch is level, and negative pitch is downward motion. The **Speed** field contains the distance that the object will travel between successive animation frames. For example, if the speed is set to 10 and there are 50 frames in the animation, then the object will travel a total of 490 (10x49) meters during the entire animation.

The **Size** fields let you scale an object along any of its axes. The X, Y, and Z size fields contain the size along each of the object’s axes. When an object is rotated, the axes move with it. Note that some imported objects may only be two dimensional. If this is the case, one of the fields will be zero and disabled.

The **Reflectivity slider** lets you adjust the amount that the selected object reflects its surroundings. If the reflectivity is set to 100%, then the objects surface color will be ignored.

The **Highlight Intensity slider** controls the object’s shininess (or the amount of light that is reflected by it).
The **Highlight Size slider** controls the amount of surface area reflects the light. Low percentage values for the highlight size make the object look shiny, and high values make it look rough or chalk-like.

Clicking the **Color Square** brings up a color adjustment dialog. The color adjustment does not affect the surface of imported objects with texture maps, because the texture is used instead of the solid color (in ray trace rendering mode).

The **Transparent** check box selects whether or not an object is transparent. Note that transparent objects will not be visible in a scene unless they have a reflectivity greater than 0%.

The **Smooth Edges** check box and **Max Angle** fields apply only to imported 3D objects that contain polygonal meshes. When edge smoothing is enabled, adjacent faces that meet at an angle less than the maximum specified value will be rendered without a sharp, visible edge. Edge smoothing is only done in ray trace mode, not in the Camera View or Quick Test modes in order to minimize the rendering time.

Imported 3D objects often consist of multiple object parts, each with unique surface characteristics. They are independantly adjustable. Select the surface (by name) that you want to adjust and then make the desired changes. A sphere shows what the resulting surface will look like when it is ray traced. Textures (if any) are not shown in the Object Properties dialog.

### Copying an Object Master

You can copy an object that has been placed in the scene, and make it available for future use by choosing the **Make Master** function in the Objects menu. The program will create a small image of the object and add it to the collection in the Objects window. This function is useful if you import an object, modify it, and wish to place additional copies of the modified object.

For example, suppose that you import a gray rock object and you wish to place 4 gray rocks and 4 black rocks in the scene:

1. Import the gray rock.
2. Place 4 copies of it in the scene.
3. Place another copy of the gray rock where you want one of the black rocks.
4. Change the gray rock you just placed to black using the Object Properties dialog.
5. Select the black rock. Choose the **Make Master** function from the Objects menu. You will see a small image of the black rock added to the collection in the Objects window.
6. Double-click on the small image of the black rock in the Objects window.
7. You can now easily place three more black rocks in the scene.
Using Preset Object Views

To facilitate object placement, orientation, and size adjustments, you can switch to various preset views of an object. There are five commands in the Objects menu for switching views - **Save View**, **Restore View**, **Top View**, **Front View**, and **Side View**.

To store the current view (so you can quickly return to it later) choose the **Save View** command in the Objects menu. **restore View** will return to the most recently saved view. To switch to a preset view (top, front, or side), first select the object in the Camera or Map window. Then select the desired preset view. When you are done making adjustments to the object, you can use the **Restore View** command (if you saved it before switching views). If you forgot to save the original view, you might be able to restore it using the **Undo View Change** command in the Edit menu. Note that the **Undo** function does not affect adjustments made to the object, only the camera viewpoint and direction.

**Tutorial: Creating Trees and Importing Objects**

Natural Scene Designer Pro can import QuickDraw 3D (3DMF) and 3D Studio (3DS) objects. You can create 3D objects in your favorite 3D modeling program, and then import them into this program to place them in a natural environment. Trees, bushes, rocks and primitive objects can be created within Natural Scene Designer Pro.

For this tutorial project, we are going to create and place some redwood trees and hot air balloons on Wizard Island, which is in Crater Lake, Oregon. We'll use a terrain model of Crater Lake and some hot air balloons.

First, choose **Open** from the File menu. Select the “Tutorials” directory on the program CD-ROM and open the file “CraterLake.nsd”.

This Crater Lake file already has the camera positioned on Wizard Island. After it opens you should see Wizard Island in the foreground, the lake, and the rim of Crater Lake in the background.

![The view from Wizard Island](image-url)
The Map is set to 1X scale, so every pixel represents 30 meters. We need to zoom into the location where the camera is at so we can see the objects we are placing. To do this, select the **Magnifier** tool.

Now, drag a small box around the location where the camera view field lines meet (the camera location). When you let go of the mouse, the program will enlarge the map scale so the area in the rectangle occupies all (or most of) the view area.

Now, the Map window should have a zoom factor of about 32X. The zoom factor is shown in the upper left corner. If it is not 32X, you can set it quickly using the zoom pop up menu (it is accessible by clicking on the scale factor).

Next, we are going to create and place three redwood trees. Choose **Create Tree** from the Objects menu. Select the **Redwood** tree type. You can change the seed and click **Preview** until you get a tree that you like. Click **OK** and a small image of the tree will be placed in the Objects window.

Double click on the tree image in the Object window (the small window below the Camera View window). This “locks” it as the current tool. If you were to single click on the small tree image, then the program would automatically revert back to the **Arrow** tool after placing a single tree. Now locate the mouse pointer over a spot on the map (within the view field) and click to place some trees. You can
use the small white circles in the Map window shown above as a guide to their placement. The hot air balloons, which we will place later, are the three large circles. Now, place the remaining trees by clicking over their location on the map.

Now we need to import and place the hot air balloons. Choose **Import 3D Object** from the Objects menu. Select the “Tutorial” folder and open one of the hot air balloon objects. After clicking **OK**, you will see the 3D Object Options dialog. Click **OK** to accept the default options. The object will load and then be displayed in the Objects window.

We will place the balloon using the Camera View window. Make sure the balloon is selected in the Objects window (with a red frame around it). Now make the Camera View window active by clicking on its title bar. To place the balloon, just click the mouse pointer in the sky. A balloon will be put there.

If you want to move the balloon, select the **Arrow** tool. Then select the balloon and drag it. If you want to change the depth of the balloon, press and hold the **Control** key before dragging it.

To delete an object that has been placed in the scene, select it with the **Arrow** tool and choose **Delete Object** from the Objects menu, or press the **Delete** key.
If you move a tree and want to make sure its base is at ground level, select it in the Camera or Map window using the **Arrow** tool and click on the **Drop to Ground** button.

When satisfied with the composition of your scene, choose **Render Picture** from the Render menu. You might want to do a **Quick Test** render first to check object placement before using the **Ray Trace** rendering mode.
Key Frames

Three-dimensional key frame systems are the most popular type of animation system in use today. You can specify the position and direction of the camera and various other settings. The program interpolates a camera path and evaluates the frames in between. This saves you from the tedious chore of manually calculating and entering coordinates for each frame.

This software lets you easily create three-dimensional camera paths. You simply create key frames at critical points along the camera path and the program automatically creates a smooth three-dimensional curve that passes through them. You may freely intermix straight and curved segments (using the **Straight** and **Curved Path** tools).

When a keyframe is selected, the Map window will display its tangent arrow. Note that this tangent arrow is only used to control the shape of the path curve, not the camera view direction. You can drag the arrowhead and interactively change the curve. In addition to the direction, you can also control the magnitude of the tangent by dragging the arrow closer or farther from the keyframe. You will get an instant preview of the resulting path.

You may select an option that sets the view direction of the camera to one that is always tangent to its path. This option is available by choosing **Direction tangent** from the Path menu.

There is another option to connect the last key frame to the first key frame. This option is selected by choosing **Closed loop** from the Path menu. There are some guidelines to follow for this to work properly. You need at least three key frames. We recommend that you use a curved path and turn the **Direction tangent** option on.
The speed and total number of output frames for the animation is set in the **Camera Speed and Frame Rate** dialog. You can access this dialog from either the Path menu or the Render Animation dialog. The total number of output frames is independent of the number of key frames used for defining the path.

To define an animation whose speed varies along the path, you should set the speed by selecting each keyframe. Then enter the speed in the Camera Settings panel.

For variable speed animations, the above dialog can be used to adjust the frame rate (frames per second during playback), but the **Speed** and **Total Frames** fields in the dialog are disabled. The program computes the total number of frames according to the camera path distance, speed (which may vary) and the frame rate.

For a constant speed animation, all fields are enabled. Adjusting one field will affect another. For example, if you change the speed or the frame rate, it will automatically change the total number of frames. If you change the total number of frames, it will adjust the speed so that the camera is able to cover the entire path in the desired number of frames.

For smooth animation you should use slow speeds when the camera is close to the ground or going around sharp curves. At high altitudes you might need a higher camera speed. Determining the best speed for smoothly animating a given path may require experimentation. The **Preview path** command in the Path menu will help you determine the best speed.

You may animate changes in the following using key frames: the camera position, direction, bank, pitch, and lens setting. Cloud and 3D object animation is independent of the key framing system. 3D object animation is accomplished by setting a starting location, speed, and direction in the Object
Properties dialog. See the cloud animation tutorial in the “Terrain Models and Settings” chapter for an example of how to animate clouds.

**Animation Dialog**
The Render Animation dialog is similar to the Render Picture dialog. It has the same controls for the picture size.

You can choose to render only part of the animation by entering the desired frame range in the **From** and **To** fields. These fields are initialized assuming that you want to render every frame in the animation.

The **Antialiasing** and **Max Levels** sliders serve the same function as in the Render Picture dialog. They are described in the “Terrain Models and Settings” chapter.
QuickTime Compression
If you specified QuickTime for saving your animation, you will be able to specify the compression method. You can specify the type of animation compression from among those available on your system, and the frames per second. The various compression methods available on your computer have trade-offs in playback speed, compression ratio, compression speed, and compressed image quality.

AVI Compression

The AVI dialog lets you choose which compressor to use, the compression quality, key frame rate, and data rates.

The list of available compressors may vary depending which version of Windows you are using and which compressors that you have installed.
Natural Scene Designer Pro can render an animation in multiple sessions. This feature is very easy to use. If you wish to stop rendering, simply click the **Suspend** button (in the Animation Progress window shown above) any time after the program has rendered at least one complete frame. You can also select the same function from the Render menu. You can use the Resume function even if there was a power outage and you never had a chance to click the **Suspend** button!
Later, when you are ready to resume rendering the animation, choose **Resume Animation Rendering** from the Render menu. It will prompt you for the name and location of the suspended animation file (which is the same name you chose when you originally started the animation rendering).

Note that if you click **Cancel** you will not have a chance to resume the animation later. You should only use **Cancel** if you notice something wrong with the animation and want to change the settings, flight path, etc. and start over.

You might be wondering how suspend and resume works -- even if you never click **Suspend** and there is a power outage. The program automatically saves a copy of your settings in the Preferences folder at the beginning of animation rendering. The partially rendered animation is saved in another file, which is the file name you choose when you started the animation. After each frame has completed rendering, it is saved in the file automatically.

**Tutorial: Example Animation**

Natural Scene Designer Pro has a built-in key frame animation system. A key frame stored in the computer contains the camera position, direction, pitch, and bank. An animation consists of two or more key frames, with the program interpolating the camera position and direction for each frame of the animation between key frames. Before creating a key frame sequence yourself, it may help to study an existing one. The “Animation” chapter will fully explain the details.

First, choose **Open** from the File menu. When the dialog appears, select the “Tutorials” directory and open the file named “ExampleAnim.nsd”.

This project is based on the previous tutorial. A straight path was created which flys out over the lake. It only took a few mouse clicks to create the path, which is shown on the Map window as a line connected by two small squares. They mark the starting and ending points. You can also create curved camera paths with multiple keyframes, which is demonstrated in the next tutorial.

To get a quick idea of what this animation looks like choose **Preview path** from the Path menu. Then you will see a low resolution preview of the animation in the Camera View window. The Map window will show the camera location and its field of view as it moves along the flight path.

To fully render the animation, choose **Render Animation** from the Render menu. Then Natural Scene Designer Pro will ask you for the name of the animation file you want to create. After entering the name of the animation file click the **Save** button. Then the program will display a dialog for you to set the size, resolution, and rendering mode. Just click **Render** to accept the default settings, and the program will begin rendering the animation.

While the animation is rendering the program displays a status window with progress information, remaining disk space, and estimated time until completion. It will also display an image of each frame after it is finished. Note that the picture displayed is always the previous frame, so it will be blank until the second frame.
If you wish to terminate the animation before it finishes, click the **Cancel** button in the Progress window. To view the completed animation, open it from the **File** menu or in a media player program.

**Tutorial: Creating a Camera Path**

We are going to create an animation of a short flight through Yosemite Valley. First, choose **Open** from the File menu. When the dialog appears, find the “Tutorials” directory and open the file named “YosemiteValley.nsd”.

For this animation, we want the camera to always point in the direction of travel. In order to accomplish this, make sure that **Direction tangent** in the Path menu has a check next to it. This is the default setting so you shouldn’t need to change it.

Now we are going to create four key frames to define the shape of the flight path. The flight path will follow a smooth curve through each key frame. Note that the key frames are used to define the shape of the curve only, and they do not affect the output frame count.

**Note:** When a key frame is selected, the program displays its tangent arrow. You can drag the arrowhead to control the shape of the path. In addition to the direction, you can control the magnitude of the tangent by dragging the arrow closer or farther from the keyframe.

If there is already a path defined, choose **Clear path** from the Path menu to erase it. If there is no path, then the **Clear path** menu item will be ghosted (unavailable).

Display the numeric Camera Settings panel by selecting the Camera tab from the Settings panel.

The Yosemite Valley floor has an elevation of about 1200 meters. Enter 1900 in the **Alt** field of the Camera Settings panel so our flight will be about 700 meters above ground.

Enter 1320 in the **Speed** field. This gives the camera a speed of 1320 meters per second, or about 3000 miles per hour! We could, of course, set a lower speed, but 1320 will allow us to complete the animation with only about 50 rendered frames.
Activate the Map window by clicking on its title bar. Then select the **Curved Path** tool.

When this tool is selected, a key frame will be created each time you click the pointer over the landscape. Now position the cross pointer so that the reading at the top of the Map window is approximately East 6750, North 6600 and click the left mouse button to create the first key frame. (The location doesn't have to be exact, but it might help if you select a map magnification factor of 4X). Next, place a key frame at East 8010, North 7500. Place another at East 9420, North 7020. Finally, place the last one at East 10650, North 7200. Now you have defined a camera flight path! The path is a white curve. Each little square marks the location of a key frame.

To see what the animation will look like, choose **Preview path** from the Path menu.

After seeing the preview, you might want to modify the path. To do this, choose the **Arrow** tool.

To select a key frame, just left click over its little box. Try selecting the first key frame now. It will turn red and its tangent arrow is displayed. Once selected, you can drag the key frame to a new location by dragging the little square box. Try dragging it around now. For more precise positioning, you may enter a numeric value in the **East**, **North** and **Alt** fields in the Camera Settings panel. Now, make sure the first key is selected and enter 7000 in the **East** field and press **Enter**. You should see it move to this location on the map.

Another way to modify the path is by using the Camera View window. Make sure that the first key frame is still selected (red). Then enter 200 in the **Distance** field in the Camera View window (press **Return** after entering the number). Now click the **Fwd** button and watch what happens to the key frame on the map. When a key frame is selected, changes you make in any of the three windows affect that key frame. When no key frame is selected, camera position changes affect only the current view, not a key frame. Deselect the first key now by clicking over a spot on the map that has no key frame. Now see what happens when you click the **Fwd** button. The key frames should remain unchanged, but the current view will still change.

Now we'll move the first key frame back to where we originally set it and start the animation. First, select it using the **Arrow** tool. Then enter 6750 in the **East** field, 6600 in the **North** field, and 1900 in the **Alt** field. Be sure to press **Enter** after entering each value. Now deselect all key frames by clicking over a blank spot on the map (this will help prevent accidental changes).

To fully render the animation, choose **Render Animation** from the Render menu. Name the animation file and click **Save**.

Next, the program will display a dialog for setting the size of the picture and the rendering mode. Just click **Render** to begin rendering the animation.
Terrain Model Sources

The program CD-ROM includes terrain models of part of California and Nevada. To access these terrain models, insert the Natural Scene Designer Pro CD-ROM in your CD drive. Then choose Open Terrain CD/DVD-ROM from the File menu. The program displays a large scale shaded relief map of the area covered by the CD. Click on a location to select a terrain model. If you want to combine a group of models, drag a rectangle around the desired area. Then click the Open button.

You may order additional CD-ROMs and DVD-ROMs from Natural Graphics. Please see our web site at "www.naturalgfx.com" for more information.

Natural Scene Designer Pro can also import data from other sources, such as the United States Geological Survey (USGS). The program accepts numerous DEM formats. Sometimes these files are compressed. If so, they need to be decompressed before importing into Natural Scene Designer Pro.

National Map

Natural Scene Designer Pro can import United States DEMs from the USGS’s National Map Viewer. They are available at http://viewer.nationalmap.gov/basic/

To obtain DEMs from this website, select “Elevation Products” on the left. Your best choice for the file format is either GridFloat or IMG. Be sure not to select ArcGrid, as it is a proprietary format which is not supported by Natural Scene Designer. Note that you will probably need to read the “How to” guides to actually download data, as the process is not immediately obvious.

Once downloaded, you may import these DEMs into Natural Scene Designer by selecting the appropriate import function from the File menu.
Map Projections

This appendix contains descriptions of the supported projections and their parameters. Most projections require multiple parameters. A few, such as “British Grid” have no parameters. You may be prompted to enter these parameters when georeferencing or reprojecting.

Parameter Descriptions

All latitudes, longitudes, parallels, meridians and angles are entered in degrees. Most distances are entered in meters, except where noted. In the following parameter descriptions, “parallels” are latitudes and “meridians” are longitudes. Note: Negative longitudes are used to specify the western hemisphere. Negative latitudes indicate the southern hemisphere. If you accidentally forget to enter the “-” when necessary, you’ll get unexpected results.

1st and 2nd Standard Parallels - Chosen latitudes where the map will have true scale. Some conic projections, such as “Albers” have two. Others, such as “Winkel Tripel” let you specify only one.

Central Meridian - A line running north and south along which all points have the same longitude. It’s the axis of symmetry or the center of the projection.

Origin Latitude - The latitude where the projection formula produces a value of zero for the “y” Cartesian coordinate, before the false northing is applied.

False Easting and Northing - Numeric values added to all x-coordinates (eastings) and y-coordinates (northings). These are usually used to avoid negative values. They don’t affect the visible output. However, when you are georeferencing an image using a TFW (world) file, you will need to enter the correct value. This is because the offsets in the TFW file are based on the false easting and northing values that were used when the image was created. If you are not using a TFW file to georeference a map, you can enter zero for the false easting and northing.

Azimuth Angle - The compass angle or the clockwise displacement from north. North is zero and east is 90, etc.

Tilt Angle - This is used in the “Tilted Perspective” projection. A value of zero would be looking straight down toward the center of the earth. A value of ninety degrees would be looking at the horizon.

Height - Used in the “Perspective” and “Tilted Perspective” projections. This is the camera height (in kilometers) of the camera above mean sea level.

Lens - Used in the “Tilted Perspective” projection. It’s the focal length of the camera lens. Use values appropriate for a standard 35mm camera. For example, 28 mm is wide angle. A normal lens is 55 mm, and a telephoto lens is usually from 135 to 400 mm.

Scale Factor - The amount of reduction or magnification.

UTM Zone - For the UTM projection, this parameter selects the central meridian. Zones are numbered from 1 to 60, 6 degrees apart starting at the international dateline and increasing eastward. The meridian is in the center of each zone.
State Plane - There are over 120 State Planes defined for the United States. Each consists of a chosen projection and parameters that are optimum for that region. Some states have one zone. Other states have multiple zones. The original State Plane System is called “State Plane 1927” and uses the North American 1927 datum (NAD27). This was later replaced by “State Plane 1983” which uses the NAD83 datum. Some states changed or combined their zones in the 1983 version.

Earth Radius - The radius of the earth, in meters. This is used for projections based on a sphere. This parameter is not available for projections which use an ellipsoidal (more accurate) earth model. Instead, they get the necessary information from the chosen datum/ellipsoid.

Projections
A “map projection” is a mathematical system that transforms points on the three-dimensional surface of the Earth to a two-dimensional surface. Projections are chosen according to their various properties. Some projections preserve shape, area, scale, distance or direction. No projection has all these properties, so a compromise must be made. Several projections described here are intended for world maps.

Projections generally fall into a few main categories based on the geometric model they use.

“Cylindrical” projections project the Earth onto a cylinder, and then the cylinder is “unrolled” to make it a flat surface. World maps often use cylindrical projections.

“Transverse Cylindrical” projections project the Earth onto a cylinder with its main axis perpendicular to the polar axis. These projections work well for regions that have a large north to south extent. “Transverse Mercator” and “UTM” projections fit this category,

“Conic” projections project the Earth onto a cone, and then the cone is unrolled. These projections work well for mid-latitude regions.

Natural Scene Designer Pro offers 40 of the most popular map projections in its projection popup menus, located in the georeferencing and reprojection dialogs. You can reproject terrain models and images. Digital Elevation Models are available most often in UTM and Geographic projections.

Available projections
Albers
Azimuthal Equidistant
Bonne
British Grid
California Teale Albers
Chamberlin Trimetric
Eckert IV
Equidistant Conic - 1 parallel
Equidistant Conic - 2 parallels
Geographic
Gnomonic
Goode Homolosine
Hammer-Aitoff
Lambert Azimuthal
Lambert Conformal Conic
Mercator
Mercator (Web)
Miller Cylindrical
Mollweide
Natural Earth
Natural Earth II
Oblique Mercator
Orthographic
Patterson
Perspective
Polyconic
Robinson
Sinusoidal
State Plane 1927
State Plane 1983
Stereographic
Tilted Perspective
Transverse Mercator
Two Point Equidistant
US Albers
UTM
Van der Grinten
Winkel I
Winkel II
Winkel Tripel

In general, map projections for world maps are based on a spherical Earth model. You can enter the Earth radius as a parameter. Projections intended for large scale maps are based on a more accurate (and more complex) ellipsoidal model of the Earth. The specified map datum determines which ellipsoid will be used.

Projections for World Maps
Bonne
Eckert IV
Geographic
Goode Homolosine
Hammer-Aitoff
Mercator (for navigation)
Mercator (Web)
Miller
Mollweide
Natural Earth
Natural Earth II
Patterson
Robinson
Sinusoidal
Van der Grinten
Winkel I
Winkel II
Winkel Tripel
Projections for Continents

Albers
Azimuthal Equidistant
Chamberlin Trimetric
Equidistant Conic - 1 parallel
Equidistant Conic - 2 parallels
Geographic
Gnomonic
Lambert Azimuthal
Lambert Conformal Conic
Orthographic
Perspective
Polyconic
Stereographic
Two Point Equidistant
US Albers

Projections Using an Ellipsoidal Model Suitable for Large Scale Maps

Albers
British Grid
California Teale Albers
Equidistant Conic - 1 parallel
Equidistant Conic - 2 parallels
Lambert Conformal Conic
Oblique Mercator
Polyconic
State Plane 1927
Transverse Mercator
UTM
Albers

A conic, equal area projection with equally spaced meridians converging at a common point. The parallels are concentric arcs that are not equally spaced. Used mostly for continental size areas and regions that are predominantly east-west in extent.

**Parameters**
- First Standard Parallel
- Second Standard Parallel
- Central Meridian
- Origin Latitude
- False Easting
- False Northing

Uses ellipsoidal Earth model

Azimuthal Equidistant

A projection where the distance between any two points passing through the center of projection is shown at true scale.

**Parameters**
- Earth Radius
- Central Meridian
- Origin Latitude
- False Easting
- False Northing

Uses spherical Earth model
Bonne

All parallels are concentric arcs of circle. They are all equally spaced. Scale is correct along the straight vertical central meridian.

**Parameters**
Earth Radius
Central Meridian
Origin Latitude
False Easting
False Northing

Uses spherical Earth model

British Grid

A Transverse Mercator projection with a Central Meridian placed 2° west of the Greenwich meridian.

**Parameters**
None

Uses ellipsoidal Earth model
California Teale Albers

This is the Albers projection with parameters optimized for the state of California. California DRGs (digitized topographic maps) are supplied using this projection.

Parameters
None

Uses ellipsoidal Earth model

Chamberlin Trimetric

This projection has a scale which is approximately correct from three widely spaced points to any other point. It is used for continent maps.

Parameters
Earth Radius
Longitude Point 1
Latitude Point 1
Longitude Point 2
Latitude Point 2
Longitude Point 3
Latitude Point 3

Uses a spherical Earth model
**Eckert IV**

Used for world maps. Has equally spaced meridians. Scale is true at latitudes $40.5^\circ$ N and $40.5^\circ$ S.

**Parameters**
- Earth Radius
- Central Meridian
- Uses spherical Earth model

**Equidistant Conic 1 Parallel**

A conic projection with equally spaced parallels and meridians converging at a common point. Scale is true along each meridian and the chosen parallel. This projection is commonly used for small countries.

**Parameters**
- Standard Parallel
- Central Meridian
- Origin Latitude
- False Easting
- False Northing
- Uses ellipsoidal Earth model
Equidistant Conic
2 Parallels

Same as Equidistant Conic - 1 parallel, but you can choose 2 parallels. Scale is true along each meridian and the two chosen parallels. This projection is commonly used for small countries.

**Parameters**
- First Standard Parallel
- Second Standard Parallel
- Central Meridian
- Origin Latitude
- False Easting
- False Northing

Uses ellipsoidal Earth model

---

Geographic

This is also known as the Plate Caree, Simple Cylindrical, and Equidistant Cylindrical projection. The meridians and parallels are equally spaced straight lines. This is the simplest projection, but the horizontal scale changes proportionally to the distance from the equator.

**Parameters**
- Central Meridian

Uses spherical Earth model
Gnomonic

A perspective projection from the center of the earth onto a plane tangent at the center of projection. On a given map, less than one hemisphere can be shown.

**Parameters**
- Earth Radius
- Central Meridian
- Origin Latitude
- False Easting
- False Northing

Uses spherical Earth model

Goode Homolosine

Natural Scene Designer Pro supports the interrupted form of this world map projection. It combines the Sinusoidal and Mollweide projections. There are 6 central meridians, arranged so that the major continents are continuous.

**Parameters**
- Earth Radius

Uses spherical Earth model
Hammer - Aitoff

An equal area projection for whole-world maps. The central meridian and the equator are the only straight lines.

Parameters
Earth Radius
Central Meridian
Uses spherical Earth model

Lambert - Azimuthal

An equal area projection that is well suited for regions that are approximately circular in extent, such as the poles and certain continents and oceans.

Parameters
Earth Radius
Central Meridian
Origin Latitude
False Easting
False Northing
Uses spherical Earth model
Lambert Conformal Conic

A conic projection that works well for regions of predominantly east-west extent. Meridians are equally spaced straight lines converging at a common point. Scale is true along the standard parallels.

**Parameters**
- First Standard Parallel
- Second Standard Parallel
- Central Meridian
- Origin Latitude
- False Easting
- False Northing

Uses ellipsoidal Earth model

Mercator

A cylindrical conformal projection with equally spaced straight meridians and unequally spaced parallels. Used for marine charts because it has straight rhumb lines.

**Parameters**
- Central Meridian
- Origin Latitude
- False Easting
- False Northing

Uses spherical Earth model
Miller

A cylindrical projection with equally spaced meridians. Scale is true along the equator. Used mostly for world maps and American atlases.

**Parameters**
- Earth Radius
- Central Meridian
- False Easting
- False Northing

Uses spherical Earth model

Mollweide

Also known as the Homolographic, Babinet, and Elliptical projections. It’s an equal area projection with true scale at latitudes 40° 41’ N and 40° 41’ S. Used for world maps.

**Parameters**
- Earth Radius
- Central Meridian
- False Easting
- False Northing

Uses spherical Earth model
Natural Earth

A world map projection with slightly rounded corners designed to emulate the spherical shape of the Earth. It has relatively low distortion compared to other world map projections.

Parameters
Central Meridian
False Easting
False Northing
Earth Radius

Uses spherical Earth model

Natural Earth II

A world map projection with a highly rounded shape. At high latitudes the meridians bend steeply inward to short pole lines. Continents look familiar without the north-south stretching found on the Eckert IV. The Natural Earth II has areal distortion values similar to those of the Robinson and Winkel Tripel projections.

Parameters
Central Meridian
False Easting
False Northing
Earth Radius

Uses spherical Earth model
Oblique Mercator

A cylindrical conformal projection for regions having a greater extent in an oblique direction, such as the Alaska panhandle and the Hawaiian Islands.

**Parameters**
- Central Meridian
- Origin Latitude
- Azimuth Angle
- Scale Factor
- False Easting
- False Northing

Uses ellipsoidal Earth model

Orthographic

A projection of the earth onto a tangent plane at an infinite distance. It can show no more than one hemisphere at a time.

**Parameters**
- Earth Radius
- Central Meridian
- Origin Latitude
- False Easting
- False Northing

Uses spherical Earth model
**Patterson**

The Patterson projection is a cylindrical projection designed for general-purpose mapmaking. It falls between the Miller, which exaggerates the size of polar areas, and the Plate Carrée, which compresses the mid latitudes. With its relatively compact 0.57 height-to-width aspect ratio, the Patterson fits nicely in printed reports, web pages, or any project needing a world map with a rectangular format.

**Parameters**
- Earth Radius
- Central Meridian
- False Easting
- False Northing

Uses spherical Earth model

---

**Perspective**

Also known as the General Vertical Perspective projection. Shows the Earth from any point above the surface, projected onto a tangent plane.

**Parameters**
- Earth Radius
- Camera Longitude
- Camera Latitude
- Camera Height
- False Easting
- False Northing

Uses spherical Earth model
Polyconic

This is also known as American Polyconic and Ordinary Polyconic. Its name means “many cones”, since it is a projection onto cones whose size varies according to the distance from the equator. It has true scale along the central meridian and each parallel.

**Parameters**
- Central Meridian
- Origin Latitude
- False Easting
- False Northing

Uses ellipsoidal Earth model

---

Robinson

Has true scale along latitudes 38 N and 38 S. The parallels and the central meridian are straight lines. Other meridians are curved. Used for world maps

**Parameters**
- Earth Radius
- Central Meridian
- False Easting
- False Northing

Uses spherical Earth model
Sinusoidal

Has equally spaced parallels. The central meridian is a straight line. Other meridians are equally spaced sinusoidal curves intersecting at the poles. Used for world maps.

**Parameters**
- Earth Radius
- Central Meridian
- False Easting
- False Northing
- Uses spherical Earth model

State Plane 1927

For mapping US states. Some states are divided into multiple zones. The State Plane system uses the Transverse Mercator, Lambert Conformal Conic, and the Oblique Mercator projections. Each zone uses one of the three projections along with parameters optimized for its region. The “1927” in the name refers to the NAD27 datum used by this system.

**Parameters**
- State Plane
- Uses ellipsoidal Earth model
State Plane 1983

Revised version of the State Plane 1927 system. Some states changed or combined their zones. Also, this system was updated to use the NAD83 datum.

Parameters
State Plane
Uses ellipsoidal Earth model

Stereographic

A conformal perspective projection of the earth onto a tangent plane from a point on the opposite side. Can show one hemisphere at a time. Recommended for conformal mapping of regions that are generally circular in shape.

Parameters
Earth Radius
Central Meridian
Origin Latitude
False Easting
False Northing
Uses spherical Earth model
Tilted Perspective

A perspective projection of the earth showing it as it appears when photographed from any point in space. This is similar to the regular “Perspective” projection, except that you can define a tilt angle, azimuth and field of view (lens focal length).

The azimuth angle is the direction the camera is pointing (0° is towards the North Pole). The tilt angle is the amount of tilt compared to looking straight down. For example, a 90° tilt angle points the camera toward the horizon, and a 0° tilt angle points it straight down.

**Parameters**
- Earth Radius
- Camera Longitude
- Camera Latitude
- Camera Height
- Camera Azimuth Angle
- Camera Tilt Angle
- Camera Lens
- False Easting
- False Northing

Uses spherical Earth model

Transverse Mercator

This is a cylindrical projection where the cylinder is rotated 90° (transverse) relative to the equator.

It is best suited for areas with a large north-south extent, such as the island of Madagascar shown above.

**Parameters**
- Earth Radius
- Central Meridian
- Origin Latitude
- False Easting
- False Northing

Uses ellipsoidal Earth model
Two Point Equidistant

This is also known as the Doubly Equidistant projection. It has true scale along a straight line from either of the two given points. Used for maps of Asia. Can also be used for distance calculations.

**Parameters**
Earth Radius
Longitude Point 1
Latitude Point 1
Longitude Point 2
Latitude Point 2

Uses spherical Earth model

US Albers

This is the Albers projection with parameters optimized for the United States. The standard parallels are 29.5° N and 45.5° N. The central meridian is -96.0° W. The origin latitude is 23.0° N.

**Parameters**
None

Uses ellipsoidal Earth model
“UTM” stands for “Universal Transverse Mercator. It’s similar to the Transverse Mercator projection, but the zone number determines the central meridian. Also, a false easting is applied so that projected coordinates are not negative. The earth is divided into 60 UTM zones, each 6° apart, having a central meridian running through the center of each zone. Zone numbers run from 1 through 60, increasing eastward from the international date line. Most terrain models of the United States use this projection.

**Parameters**
- UTM Zone

Uses ellipsoidal Earth model

This projects the Earth into a circle. It is a compromise projection that is neither equal-area nor conformal. Used for world maps.

**Parameters**
- Earth Radius
- Central Meridian
- False Easting
- False Northing

Uses spherical Earth model
Web Mercator

This is the same as the Mercator projection, however the aspect ratio is 1:1. It is used primarily for web mapping.

Parameters
None

Uses spherical Earth mode

Winkel I

A pseudocylindrical projection with equally spaced parallels. The central meridian is a straight line and all others are equally spaced sinusoidal curves. Used for world maps.

Parameters
Earth Radius
Central Meridian
Standard Parallel
False Easting
False Northing

Uses spherical Earth model
Winkel II

A pseudocylindrical projection with equally spaced parallels. The central meridian is a straight line and all others are elliptical arcs. Used for world maps.

**Parameters**
- Earth Radius
- Central Meridian

Uses spherical Earth model

Winkel Tripel

A modified azimuthal projection. The equator and central meridian are straight lines. All other parallels and meridians are curved. Used for world maps.

**Parameters**
- Earth Radius
- Central Meridian
- Standard Parallel
- False Easting
- False Northing

Uses spherical Earth model
Map Datums

This appendix lists the map datums supported by Natural Scene Designer Pro. You need to select a datum when georeferencing or reprojecting.

Definition

Geodetic datums define the origin and orientation of an earth coordinate system, along with its size, shape and the location of the center. The earth is neither a perfect sphere nor an ellipsoid. It is a complex surface, a “geoid” with variations of hundreds of meters from a true ellipsoid. Throughout the years, datums have evolved significantly, especially since the beginning of the space age, satellites, and GPS.

There are hundreds of datums that have been developed. Most datums are designed to provide the best fit for a given region, state, country, or continent. Many countries developed their own datums. They are shown here in the “Supported Datums” list.

For large scale maps it is important to use the correct datum. Otherwise there could be position errors in the hundreds of meters. For scanned paper maps, the datum is usually listed in the map border. For maps supplied digitally, the datum will be found in one of the accompanying files. In some cases, such as GeoTIFF, the datum is supplied in the image file itself.

“World Geodetic Datum 1972” and “World Geodetic Datum 1984” are datums that fit the entire earth in one datum with the least possible average error, but they are not ideal for most smaller regions.

Supported Datums in NSD Pro

Adindan, Mean
Adindan, Ethiopia
Adindan, Sudan
Adindan, Mali
Adindan, Senegal
Adindan, Burkina Faso
Adindan, Cameroon
Afgooye, Somalia
Antigua Island Astro 1943
Ain El Abd 1970, Bahrain
Ain El Abd 1970, Saudi Arabia
American Samoa 1962,
Anna 1 Astro 1965, Cocos Is.
ARC 1950, Mean
ARC 1950, Botswana
ARC 1950, Lesotho
ARC 1950, Malawi
ARC 1950, Swaziland
ARC 1950, Zaire
ARC 1950, Zambia
ARC 1950, Zimbabwe
ARC 1950, Burundi
ARC 1960, Kenya & Tanzania
ARC 1960, Kenya
ARC 1960, Tanzania
Ascension Island 1958
Montserrat Island Astro 1958
Australia Astro 1952, Marcus Is.
Astro Beacon E 1945, Iwo Jima
Australian Geodetic 1966
Australian Geodetic 1984
Djakarta, Indonesia
Bissau, Guinea-Bissau
Bermuda 1957, Bermuda Islands
Bogota Observatory, Columbia
Bukit Rimpah, Banka & Belitung
Cape Canaveral, Fl & Bahamas
Campos Inchauspe 1969, Arg.
Canton Astro 1966, Phoenix Is.
Cape, South Africa
Camp Area Astro, Camp McMurdo
S-JTSK, Czech Republic
Carthage, Tunisia
Chatham Island Astro 1971, NZ
Chua Astro, Paraguay
Corrego Alegre, Brazil
Dabola, Guinea
Deception Island
Gux 1 Astro, Guadalcanal Is.
Easter Island 1967
Wake-Eniwetok 1960
Estonia, 1937
European 1950, Mean, 3 Param
European 1950, Mean, 7 Param
European 1950, Western Europe
European 1950, Greece
European 1950, Norway & Finland
European 1950, Portugal & Spain
European 1950, Cyprus
European 1950, Egypt
European 1950, England, Channel
European 1950, Iran
European 1950, Sardinia, Italy
European 1950, Sicily, Italy
European 1950, England, Ireland
European 1950, Malta
European 1950, Iraq, Israel
European 1950, Tunisia
European 1979
Oman
Observatoria Met. 1939, Flores
Fort Thomas 1955, Leeward Is.
GAN 1970, Rep. of Maldives
Geodetic Datum 1949, NZ
Gizo Island
Graciosa Base SW 1948, Azores
Guam 1963
Gunung Segara, Indonesia
Herat North, Afghanistan
Hermannskogel, Old Yugoslavia
Provisional South Chilean 1963
Hjorsey 1955, Iceland
Hong Kong 1963
Hu-Tzu-Shan, Taiwan
Bellevue, IGN, Efate Is.
Indonesian 1974
Indian, Bangladesh
Indian, India & Nepal
Indian, Pakistan
Indian 1954, Thailand
Indian 1960, Vietnam 16N
Indian 1960, Con Son Island
Indian 1975, Thailand
Indian 1975, Thailand
Ireland 1965
ISTS 061 Astro 1968, S Georgia
ISTS 073 Astro 1969, Diego Garcia
Johnston Island 1961
Kandawala, Sri Lanka
Kerguelen Island 1949
Kertau 1948, W Malaysia & Sing.
Korean Geo Datum 1995, S Korea
Kusaie Astro 1951, Caroline Is.
L.C. 5 Astro 1961, Cayman Brac
Leigon, Ghana
Liberia 1964
Luzon, Philippines
Luzon, Mindanao Island
Massawa, Ethiopia
Merchich, Morocco
Midway Astro 1961, Midway Is.
Mahe 1971, Mahe Is.
Minna, Cameroon
Minna, Nigeria
Rome 1940, Sardinia
M’Poraloko, Gabon
Viti Levu 1916, Viti Levu Is.
Nahrwan, Masirah Island, Oman
Nahrwan, United Arab Emirates
Nahrwan, Saudi Arabia
Naparima, Trinidad & Tobago
North American 1983, CONUS
North American 1983, Alaska
North American 1983, Canada
North American 1983, Mexico
North American 1983, Aleutian
North American 1983, Hawaii
North American 1927, CONUS
North American 1927, Eastern US
North American 1927, Western US
North American 1927, Alaska
North American 1927, Canada
North American 1927, Alberta-BC
North American 1927, E. Canada
North American 1927, Man-Ont
North American 1927, NW Terr.
North American 1927, Yukon
North American 1927, Mexico
North American 1927, Michigan
North American 1927, C. America
North American 1927, Canal Zone
North American 1927, Caribbean
North American 1927, Bahamas
North American 1927, Cuba
North American 1927, Greenland
North American 1927, Aleutian E.
North American 1927, Aleutian W
North Sahara 1959, Algeria
Old Egyptian 1907
Ordnance GB 1936, Mean, 3 Param
Ordnance GB 1936, England
Ordnance GB 1936, Eng., Wales
Ordnance GB 1936, Scotland
Ordnance GB 1936, Wales
Ordnance GB 1936, Mean, 7 Param
Old Hawaiian CC, Mean
Old Hawaiian CC, Hawaii
Old Hawaiian CC, Kauai
Old Hawaiian CC, Maui
Old Hawaiian CC, Oahu
Old Hawaiian IN, Mean
Old Hawaiian IN, Hawaii
Old Hawaiian IN, Kauai
Old Hawaiian IN, Maui
Old Hawaiian IN, Oahu
Ayabelle Lighthouse, Djibouti
Pitcairn Astro 1967
Pico De Las Nieves, Canary Is.
Porto Santo 1936, Madeira Is
Provisional S American 1956, Bolivia
Provisional S American 1956, N Chile
Provisional S American 1956, S Chile
Provisional S American 1956, Colombia
Provisional S American 1956, Ecuador
Provisional S American 1956, Guyana
Provisional S American 1956, Peru
Provisional S American 1956, Venez
Provisional S American 1956, Mean
Point 58, Burkina Faso & Niger
Point Noire 1948, Congo
Pulkovo 1942, Russia
Puerto Rico & Virgin Is.
Qatae National
Qornoq, South Greenland
Reunion, Mascarene Is.
Santo, Dos, 1965
Sao Braz, Santa Maria Is
Sapper Hill 1943, E Falkland Is.
SIRGAS, South America
South American 1969, Mean
South American 1969, Argentina
South American 1969, Bolivia
South American 1969, Brazil
South American 1969, Chile
South American 1969, Colombia
South American 1969, Ecuador
South American 1969, Guyana
South American 1969, Paraguay
South American 1969, Peru
South American 1969, Baltra
South American 1969, Trinidad
South American 1969, Venezuela
Schwarzeck, Namibia
Selvagem Grande 1938, Salvage Is.
Astro DOS 71-4, St. Helena Is.
South Asia, Singapore
S-42, Pulkovo 1942, Hungary
S-42, Pulkovo 1942, Poland
S-42, PK 42, Former Czechoslovakia
S-42, Pulkovo 1942, Latvia
S-42, PK 1942, Kazakhstan
S-42, Pulkovo 1942, Albania
S-42, Pulkovo 1942, Romania
Sierra Leone 1960
Tananarive Observatory 1925
Tristan Astro 1968
Timbalai 1948, Brunei & E Malay
Tokyo, Japan
Tokyo, South Korea
Tokyo, South Korea
Tokyo, Okinawa
Tokyo, Mean
Astro Tern Island, Frig, 1961
Voirol 1874, Algeria
Voirol 1960, Algeria
Wake Island Astro 1952
World Geodetic System 1984
World Geodetic System 1972
Yacare, Uruguay
Zanderij, Suriname
Index

3D object animation 128
3D Object Options 118, 125
3D objects 13, 20, 116
3DMF 13, 31, 123
3DS 13

A

Above Surface 26
Active tool 119
Add tool 68
Adjust tool 67, 68
Albers 137, 140
Alt 112
Altitude 13
Always Include 118
Ambient light 64
Angles 15
Animating Clouds 53
Animation 11
Anti-aliasing 69, 129
Arrow Tool 104, 116
Auto Bank 35, 114
Automatic update checking 9
AVI Compression 130
Avoid collisions 35
Azimuth 66
Azimuth Angle 136
Azimuthal Equidistant 137, 140

B

Babinet 148
Backface 118
Background Tree Map 58
Background Trees 21, 30, 56
Bank 11, 16, 113
Bank control 108
BIL DEM 28, 135
BMP 13
Bonne 137, 141
British Grid 137
Bump Mapping 47
Bushes 11, 13, 60
C
California Teale Albers 137, 142
Camera 15
Camera lens 16
Camera movement 107
Camera Settings 37
Camera Settings Panel 112
Camera Speed 35
Camera View window 9, 13, 16, 21, 24, 107
Camera viewpoint 13
Camera Window Aspect Ratio 115
Central Meridian 136
Chamberlin Trimetric 142
Clear path 36, 133
Clear Selection 29
Clipping Terrain Models 12
Clipping Tool 105
Close 28
Closed loop 35, 127
Clouds 14, 20, 53
Color Distribution 74
Color Square 122
Combining Terrain Models 12, 41
Compass direction 15
Composition 13, 22, 108
Conic 137
Contour Maps 34, 77
Contrast 46
Copy 29
Copy GeoTIFF tags 34
Create Fractal Terrain 28
Create SVG Files for Shapes 79
Create Tree 31, 55, 119, 124
Creating Terrain Models 43
Curved Path 106, 127, 134
Cut 29
Cylindrical 137

D
Datums 11, 99, 100
Decimal Latitude / Longitude 115
Decollar 34
decollar 101
Decollaring 12
Default Light Source 66, 67
Delete 29
Delete Key Button 103
Delete Master 32
Delete Object 32, 125
DEM Clipping 41
Detect collisions 35
Digital Elevation Models 13
Dir 112
Direction 15, 121
Direction buttons 22
Direction tangent 35, 127, 133
Distance 22, 107, 134
Distance Mask 71
Doubly Equidistant 156
DPI 69
Drape Image 34, 90, 101
DRG 12, 99
Drop to Ground 26, 103, 126
DXF 13

E
Earth Radius 137
Earth Sphere 44
East 112
Eckert IV 137, 143
Edge Smoothing 118
Elevation 24
Elevation Angle 66
Ellipsoid 138, 160
Elliptical 148
Equidistant Conic 137
Equidistant Conic - 1 Parallel 143
Equidistant Conic - 2 Parallels 144
Equidistant Cylindrical 144
Eraser 104
Export Ascii Grid DEM 29
Export Grayscale 28
Export GridFloat DEM 29
Export keyframes 35, 36
Export Landscape 28
Export Overlay 34
Export terrain 63
Eye Dropper 104, 111

F
False Northing 136
Field of view 25
File formats 13
Flight path 13
Focal length 16
Fractal landscape 8, 12, 42-43
Frame range 129
Frame tool 22, 124
Front View 32
G

General Vertical Perspective 151
Geodetic Datum 1984 160
Geographic 137, 144
Georeference 30, 33, 88
Georeferencing 11
Georeferencing Methods 85
Georeferencing Tutorial 88
Globe Rendering Tutorial 91
Gnomonic 137, 145
Goode Homolosine 137, 145
Grabber Tool 25, 106
Grayscale 84
Grayscale picture 13, 40
GridFloat 135
GridFloat DEM 28
GTOPO 30 135

H

Hammer-Aitoff 137, 146
Hand Tool 22, 25, 104
Height 8, 136
Height Mask 71
Highlight Intensity 121
Highlight Size 122
Homolographic 148
Horizon 16

I

Import 3DMF 118, 125
Import Ascii Grid DEM 28
Import DRG or DOQ 49
Import Georeferenced Image 33, 50
Import Grayscale DEM 28
Import GridFloat DEM 82
Import Image 33
Import IMG DEM 28
Import keyframes 36
Import Overlay 48
Import SRTM DEM 28
Import USGS DEM 28
Importing USGS DEMs 41
Insert Key Button 103
Installation 15
J
JPEG 13

K
Key frame 18, 19, 132, 134

L
Lake Tool 105
Lakes 14, 26, 30, 54
Lambert Azimuthal 137, 146
Lambert Conformal Conic 137, 147
Landscape 8, 12, 21
Landslapes
  combining 41
Large scale maps 160
Lens 16, 113
Light 37
Light Settings panel 64
Lighting angle 64
Load Tree Map 58
Location 121
Location Tool 24, 106
Lower Tool 105, 111

M
Magnification factor 26
Magnifier tool 26
Make Master 32, 122
Map 12
Map Window 13, 24, 37, 109, 120
Map Window in Profile Mode 110
Mars 8, 48
Max Angle 122
Maximum Levels 70, 129
Menu 27
Mercator 137, 147
Miller 137, 148
Mollweide 138, 148
Moon 8
Motion fields 121
Multiple Lights 66
Multithreading 115
N
NASA 90
National Map 135
Natural Earth 149
Natural Earth II 149
New 27, 42–65
Next Key Button 104
North 112

O
Oak trees 11, 13, 31, 55, 119
Object Properties 118
Objects window 116
Oblique Mercator 138, 150
Ocean 14, 54
Ocean level 54
Online support 14
Open 28
Open CD-ROM Map 39
Open Terrain CD/DVD-ROM 28, 39, 103
OpenGL 13
Origin 15
Origin Latitude 136
Orthographic 138, 150
Output File formats 13
Output Image Settings 95
Overlay Manager 37
Overlays Panel 51

P
Paint Brush 104, 111
Paint Bucket 105, 111
Palette 83
Palm trees 11, 13, 31, 55, 119
Panorama 69, 72
Parallels 136
Patterson 151
Perspective 138, 151
Phone support 14
Picture
Composition 108
Size 69
Units 69
Picture overlay 48
Pitch 16, 112, 121
Pitch control 108
Plan Oblique Relief 75
Plane 44
Plate Caree 144
Revert to Saved  28
Robinson  138, 152
Rock  45
Rock Texture  62
Rocks  14, 61
Rotate Tool  105, 117

S

Save As  28, 71
Save Merged  34
Save View  32, 123
Scalable Vector Graphic  79
Scale  118
Scale Factor  136
Seed  8, 53, 55
Selection/ Dragging Tool  134
Set Terrain Sample Distance  30
Settings Panel  19
Shaded Relief Maps  73
Shadow Mask  71
Shadows  64
Shape Files  10, 12
Show as Box  32
Show Directions  68
Show Object  32
Side View  32
Simple Cylindrical  144
Sinusoidal  138, 153
Size  69, 121
Sky  14, 30, 51, 52
Sky Mask  72
Sky Settings dialog  51
Smooth Edges  122
Snow  45
Soil  45
Speed  113, 121, 133
Spherical VR Panoramas  9
Startup Settings  114
State Plane  137
State Plane 1927  138, 153
State Plane 1983  138, 154
Status line  24
Status window  132
Stereographic  138, 154
Stop Preview  33, 35
Stop rendering  23, 70
Straight Path  106, 127
Sun Position  65
Suspend and Resume  131
SVG  9, 79
Sweet Gum 11, 13, 31, 55, 119  
System Requirements 14

T

Technical Support 14  
Telephoto 25  
Terrain Bump Map 30, 47  
Terrain Editing 12  
Terrain Editor 111  
Terrain Info 100  
Terrain Information Dialog 40  
Terrain Model Sources 136  
Terrain models 38  
Terrain Overlays 12  
Terrain photograph overlay 13  
Terrain Settings 30  
Texture 118  
Texture Shade 36  
Texture Shading 81  
TFW 12, 85, 86, 90, 136  
TIFF 13  
TIFF DEM 28  
Tilt Angle 136  
Tilted Perspective 136, 138, 155  
Tom Patterson 91  
Tool Options 37  
Toolbar 13, 103  
Top View 32  
Topography 8  
Transparent objects 122  
Transparent Sky 10, 12, 71, 72  
Transverse Cylindrical 137  
Transverse Mercator 138, 155  
Tree trunks 11, 13  
Trees 11, 13, 55, 123  
Tutorials 14, 123  
Two Point Equidistant 138, 156

U

U.S. Geological Survey 7, 28  
Undo 19, 29, 103, 107  
Undo View Change 123  
Units 69  
US Albers 138, 156  
USGS 7  
USGS DEM 13  
UTM 137, 138, 157  
UTM Zone 38, 136
V
Van der Grinten 157
Vegetation 45
Version 14
Vertical Enhancement 83
Vertical Exaggeration Factor 30, 48
View Changing Tool 25, 106
View direction 22, 108
View field 25
Viewshed Maps 36, 76
Visible Earth 90

W
Water 14, 30, 54
Wave Height 54
Web Mercator 158
Wide angle 25
Winkel I 138, 158
Winkel II 138, 159
Winkel Tripel 138, 159
World files 12, 85, 86
World Geodetic Datum 1972 160
World maps 138
World Settings 30, 44
www.shadedrelief.com 91

Z
Zoom 19
Zoom factor 124